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1. FAID Quantum Fatigue Assessment 

Software Introductory Notes 

InterDynamics’ FAID software and Biomathematical Model (BMM) has been an industry 

standard for fatigue exposure prediction and fatigue management since its introduction in the 

late 1990s. In 2016, InterDynamics set a new standard with FAID Quantum, which offers a 

whole new level of scientifically-verified alertness prediction with a new BMM.  FAID Quantum 

software can be customised according to the users’ needs to include: 

• FAID Score - using the FAID original BMM  

• Optional Sleep Prediction and KSS Score - using the FAID Quantum BMM 

• Optional time zone adaption (for adjustments when travelling over multiple time zones) 

• Optional crew augmentation (for resting pilots on long flights) 

The following document includes details of the two Biomathematical Models and all the software 

options.  Please disregard information that does not apply to your needs and software options. 

A user of a BMM is responsible for understanding how it works and its suitability for the purpose 

it is being used for.  Please read BMM Warning for further details. 

 

1.1. FAID Quantum Fatigue Assessment Software and 

Fatigue Risk Management 

Fatigue levels for individuals can be the result of a number of factors including recovery sleep 

achieved (quality and quantity), hours of work impacts, workload, environment, health issues, 

and individual susceptibility/resilience to fatigue. Both work and non-work related fatigue factors 

contribute to safety risks at work, and as a result require proactive management by individuals 

and the organisation to ensure the risks associated with fatigue are controlled to a tolerable 

level. 

 

FAID Quantum is a powerful analytical tool 

based on scientific knowledge which can 

support the management of hours of work 

within an organisation’s fatigue risk 

management guidelines. Managing hours of 

work taking into account fatigue is one of the 

major elements of a proactive and effective 

Fatigue Risk Management System (FRMS). 

Please refer to InterDynamics’ website for a 

discussion on other key elements of an 

FRMS. 

 

https://www.interdynamics.com/download/documents/BMM-Warning.pdf
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1.2. What you need to know about FAID Quantum 

FAID Quantum has been developed using scientific research and knowledge gained over 

several decades on circadian factors, the effects of shift lengths, timing of shifts and the 

importance of previous work periods on fatigue and performance. The FAID Quantum software 

contains two biomathematical models of human alertness response to work and rest patterns 

associated with trans-meridian travel. 

Many regulators and industry bodies recognise that within an FRMS, adequate management of 

fatigue-related risks associated with working hours involves more than simply limiting working 

hours. Circadian influences and biological limits to recovery are also important. Consideration of 

these factors and possible adaptation to time zone changes can most effectively and efficiently 

be supported by the strategic use of biomathematical models such as those in FAID Quantum. 

FAID Quantum has been designed to be a powerful decision support tool based on what can be 

known with confidence: working hours or duty periods. FAID Quantum uses work hours (in UTC 

and local time for time zone version) as its inputs to predict the effect on fatigue and 

performance of different duty periods or work schedules, taking into account rest time and the 

number of time zones crossed. It models human biology and is best used as a statistically 

significant indicator of general human response, but not as a predictor of an individual’s 

condition. This is true of all models given that variations in sleep requirements and tolerances 

do exist within the human population. 

FAID Quantum considers the influence of work periods (time of day, length, how recent and 

time zones travelled) and human biological limits associated with sleep and recovery to 

determine work-related fatigue scores. FAID Quantum does not consider other personal factors 

that contribute to an individual’s fatigue (i.e. sleep disorders, health, sleeping conditions etc.). 

However, there is an option to review the fatigue exposure taking into account less than full 

quality sleep during in-flight rest periods (“augmentation”). Like any biomathematical model, 

which (by definition) uses general population level data to provide a view of relative fatigue 

exposures, neither FAID Quantum nor any other model in the market can provide an accurate 

prediction of an individual’s level of fatigue. To try to do so with FAID Quantum or any other 

fatigue model would be inappropriate. Individuals will always need to be considered and 

managed as individuals, within any fatigue risk management regime. 

FAID Quantum does provide the option for actual sleep obtained to be considered in its 

calculations, if such data is available. While this enables FAID Quantum to reflect more closely 

the experience of an individual, the results are still based upon a statistical model representing 

the general population response to that sleep pattern and not a prediction of the individual’s 

level of fatigue. 

1.3. The FAID Quantum Biomathematical Models 

No biomathematical model (BMM) can predict work-related fatigue completely, however the 

likelihood of fatigue impairment associated with different work hours can be reviewed using 

FAID Quantum software which includes two discrete BMMs. 

Each of these BMMs has its own characteristics, sensitivities and strengths which are described 

in detail in the following sections. 
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1.3.1. FAID Standard BMM 

The FAID Standard BMM was first released by InterDynamics in 1999 and has been a reliable 

contributor to assessing and managing fatigue risk since then. 

A FAID Score is provided, indicating different levels of fatigue exposure for different work hours. 

The higher the FAID Score the higher the fatigue exposure. 

Using formulae and factors developed and validated by Dr Adam Fletcher and Professor Drew 

Dawson at the Centre for Sleep Research, University of South Australia, the FAID Standard 

BMM provides a representative score of the hours of work related fatigue exposure of a worker, 

based on the following biological determinants of fatigue:  

a. Time of day of work and breaks 

b. Duration of work and breaks 

c. Work history in the preceding seven days 

d. Biological limits on recovery sleep 

This model is structured upon a probabilistic scoring method with weighting scores for each 

hour of a day for both work and rest. This model is most sensitive to the cumulative effects of 

consecutive work periods, particularly those at night. 

1.3.1.1. Validation and assumptions 

The formula and factors used by the FAID Standard BMM have been validated within simulated 

work environments and field-based situations by the Centre for Sleep Research, University of 

South Australia. 

Provided below are the major assumptions used to develop the FAID Standard BMM. 

1. Recovery from work-related fatigue by sleeping can be obtained at any time an individual 

is not working. The amount of recovery sleep assumed at any point in time is a subset of 

the opportunity available, dictated by time of day and competition from factors such as 

social pressures (Dean, Fletcher, Hursh, & Klerman, 2007). FAID is a statistical model and 

considers the changing likelihood and quality of recovery sleep at different times of the day.  

2. The FAID Standard BMM takes into account a rolling 7-day history in its analysis, giving 

consideration to the accumulating impact of fatigue over the past 7 days. There is no 

weighting given to time further back than 7 days or 168 hours.  

3. Individuals can only recover from fatigue that has been accumulated and cannot store 

recovery to offset against potential future fatigue (Dawson & Fletcher, 2001). 

The development and validation of the FAID Standard BMM is well substantiated and has been 

published in numerous international peer-reviewed journals and books. 

1.3.1.2. FAID Score 

A standard work week of 40 hours, Monday to Friday, 9 a.m. to 5 p.m., when analysed, results 

in a peak FAID Score of 41. By comparison, a 40-hour week of 11 p.m. to 7 a.m. night shifts 

results in a peak FAID Score of 97. A study by Dawson and Reid indicates that scores between 

80 and 100 (high fatigue likelihood) are comparable to the level of fatigue-related impairment 

after 21-24 hours of continuous sleep deprivation (Dawson & Reid, 1997). This result was 

observed when the sleep deprivation started at 8 a.m. on a Monday, following a standard 

working week and weekend break. Multiple studies have shown that performance impairment at 
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such a level of sleep deprivation is comparable to that experienced at blood alcohol 

concentrations of over 0.05% (Fletcher, Lamond, van den Heuvel & Dawson, 2003). 

A FAID Score can provide an indication of the likelihood of performance impairment associated 

with fatigue. Validation studies suggest that work-related FAID Scores correlate very highly with 

sleep-onset latency, neurobehavioural impairment and subjective sleepiness (Fletcher, 1999). 

This score is used by the FAID Standard BMM. 

 

Risk Profile displaying how many individuals peaked in Green, Yellow or Red FAID Score Condition 

 

1.3.2. FAID Quantum BMM 

The FAID Quantum BMM was introduced in 2016 and incorporates sleep prediction together 

with results in the more familiar Karolinska Sleepiness Scale (KSS). 

The FAID Quantum BMM sleep prediction is based upon formulae developed by Dr David 

Darwent in conjunction with Professor Drew Dawson and Dr Greg Roach of the Appleton 

Institute, Central Queensland University.  These algorithms are the best sleep-wake predictors 

that have yet been published (at the time of writing) in international peer-reviewed literature 

(Darwent, Dawson & Roach, 2012). 

The FAID Quantum BMM is able to determine a predicted KSS score from predicted sleep 

periods utilising an implementation of the Three Process Model of Alertness (Akerstedt & 

Folkard,1995). The implementation in FAID Quantum BMM does not include the sleep inertia 

component of that model. 

Most importantly, the FAID Quantum BMM allows organisations to see each of the steps in 

predicting fatigue.  That is, the work-rest schedule, the estimated sleep-wake schedule and the 

resultant fatigue expressed as a KSS score. 

By making the predicted sleep/wake schedule explicit, it is possible to review the degree with 

which the model is reflecting the real world experience of workers. This creates a direct 

measurable feedback mechanism for verifying FAID Quantum based on unique organisational 

data. This is a critical element of audit and compliance of a BMM as required under many 

regulatory environments. 

FAID Quantum also provides the option for actual sleep obtained to be considered in its 

calculations. See Section 1.7.4 Actual Sleep. 
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The FAID Quantum BMM focusses on the sleep periods consequential to the work periods and 

is particularly sensitive to sleep pattern disruptions and day-time sleep. 

1.3.2.1. Validation 

The formula and factors used by the FAID Quantum BMM have been validated by what may be 

the largest database of quality sleep-wake data in the world, incorporating nearly 15,000 days 

and nights of data collected by the Appleton Institute, Central Queensland University from 

various industries (including long-haul aviation) to underpin predictions. 

The development and validation of the FAID Quantum BMM is well substantiated and has been 

published in numerous international peer-reviewed journals and books. 

1.3.2.2. Karolinska Sleepiness Scale (KSS) 

The KSS is a 9 point Likert scale often used when conducting studies involving self-reported, 

subjective assessment of an individual’s level of drowsiness at the time. 

The KSS scores are defined as follows: 

9.  Extremely sleepy, fighting sleep 

8.  Sleepy, some effort to keep alert 

7.  Sleepy, but no difficulty remaining awake 

6.  Some signs of sleepiness 

5.  Neither alert nor sleepy 

4.  Rather alert 

3.  Alert 

2.  Very alert 

1.  Extremely alert 

 

The KSS has an extensive body of literature linking KSS scores to actual workplace 

performance and objective measures of fatigue. The FAID Quantum BMM incorporates the 

Karolinska Sleepiness Scale, providing predicted KSS Scores, enabling the user to better 

understand the numeric output aided by the descriptions associated with each score value. 

 

Risk Profile displaying how many individuals peaked in Green, Yellow or Red KSS Condition 
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1.4. Setting Tolerance Levels 

Biomathematical models do not make decisions on which work schedules are most appropriate 

in specific workplaces. What the models do, however, is provide information that can be useful 

when decisions about fatigue management need to be made. Tracking KSS & FAID Score 

results in relation to incident frequency, absenteeism levels, employee sick days or other 

organisationally meaningful data would allow a clearer illustration of the relationship between 

hours of work and its related costs. 

Hours of work-related fatigue exposure can be limited by allocating work hours within a 

tolerance level or benchmark score. 

As FAID Quantum produces both KSS and FAID scores it provides the facility for the user to set 

a KTL (KSS Tolerance Level) and a FTL (FAID Score Tolerance Level). Desirable 

compliance percentages can also be set. FAID Quantum provides reports specific to these 

settings. 

Different Tolerance Levels may be set for specific tasks or roles. A lower Tolerance Level may 

be set for a higher risk task or role, and a higher Tolerance Level may be set for a lower risk 

task or role. For a specific task or role, one Tolerance Level may be used for planned hours of 

work, with the option of reviewing actual hours against a higher Tolerance Level, acknowledging 

that variances to the plan may occur on day of operations. 

The list below represents an example of a combination of hours of work rules that could fit 

within an organisation’s FRMS guidelines, utilising FAID Quantum software as a key component 

in the development and audit of fatigue risks associated with hours of work: 

• A Tolerance Level of x (or multiple Tolerance Levels for tasks of various risks) 

• Monthly, or roster cycle period compliance to Tolerance Level of all shifts for each 

individual to be no less than y% 

• Individual shifts should not exceed z points above the Tolerance Level 

• Varying levels of actions/controls to be applied as exposures approach/exceed 

Tolerance Level 

• Potential for differing values of x, y, and z for planned and actual hours. 

Tolerance Levels and target compliance percentages are usually determined by an organisation 

after carrying out a Fatigue Hazard Analysis (FHA) risk assessment for a specific role1. That is, 

a risk assessment which reviews the hazards of a role when fatigue is present. The risk 

assessment would take into account (among other things) the current hours of work fatigue 

exposure analysed using FAID Quantum, including, importantly, the Apparent Tolerance Levels 

(the overall hours of work fatigue exposure currently being tolerated by the organisation). 

For more information on Tolerance Levels, please see Establishing Fatigue Tolerance Levels. 

 
1 InterDynamics’ risk assessment methodology founded on Zurich’s Hazard Analysis methodology aligned with AS/NZS ISO 31000:2009. 

https://www.interdynamics.com/download/documents/EstablishingAnFTL.pdf
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Apparent Tolerance Level - KSS 

 

Apparent Tolerance Level - FAID Score 

 

Understanding and managing an organisation’s risk profile with relation to fatigue is an 

important process within a FRMS that involves looking at multiple areas of exposure. For 

example, a view of the organisation’s fatigue risk profile can be gained by determining the: 

• Fatigue risk profile of the workforce through an employee Managing Fatigue Survey; 

• Hours of Work risk profile through a FAID Quantum Hours of Work Diagnostic of 

planned and actual hours worked;  

• Workplace hazards in the context of fatigue, associated with specific roles and 

environmental factors through a Fatigue Hazard Analysis risk assessment; 

• Drawing it all together with a fatigue risk grading will provide contextual data on the 

specific, system level fatigue-related risks for the organisation, and how to manage them 

effectively within a true risk-management framework. 

As can be seen, the use of FAID Quantum in determining the Hours of Work risk profile is one 

component of many. 

http://www.interdynamics.com/fatigue-risk-management-solutions/fatigue-risk-management-services/managing-fatigue-surveys/
http://www.interdynamics.com/fatigue-risk-management-solutions/fatigue-risk-management-services/hours-of-work-diagnostics/
https://www.interdynamics.com/fatigue-risk-management-solutions/fatigue-risk-management-services/fatigue-hazard-analysis-risk-assessments/
http://www.interdynamics.com/fatigue-risk-management-solutions/fatigue-risk-management-services/fatigue-risk-management-system-frms-management-workshops/
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1.5. Research into circadian disruptions from 

changing time zones 

The biggest challenge posed by multiple time-zone movement is the time required for the body 

to adjust to the new time-zone. 

Research is not 100% conclusive regarding how adaptation to time zones occurs. There are, 

however, some principles that are generally agreed. 

A number of researchers have proposed that the period of adjustment appears to depend on 

the direction of travel. Adjustment appears to be faster after westbound flights than eastbound 

flights (Klein & Wegmann, 1980).  

More recent research (Waterhouse, Reilly, Atkinson & Edwards, 2007) has found that 

adaptation to an eastwards shift of more than 3 time zones takes, on average, two thirds as 

many days as the number of time zones crossed. That is, a 9E shift takes 6 days; a 6E takes 4 

days, etc. 

Additional research (Waterhouse, Edwards, Nevill, Atkinson, Reilly, Davies & Godfrey, 2000) 

found that adaptation to a westward shift of more than 3 time zones takes, on average, one half 

as many days as the number of time zones crossed. That is, an 8W takes 4 days; a 6W takes 3 

days, etc. 

Two other key papers (Auger & Morganthaler, 2009 and Eastman, Gazda, Burgess, Crowley, & 

Fogg, 2005) concluded that the maximum shift eastwards in any 24-hour period is 1.5 hours 

and in a westward direction is 2 hours. 

It is now generally considered reasonable to make predictions of up to 9 hours East and 12 

hours West. Between these there is a ‘grey zone’ in which shifts can occur in the opposite 

direction to the physical direction of travel; for example, a 10-hour Easterly trip by the body can 

be associated with the circadian sleep/wake rhythm adjusting 14 hour Westward. 

Some researchers (Klein & Wegmann, 1980) propose that resynchronisation is best expressed 

as 50% of the remaining difference between body clock and local time every 48 hours. 

It is important to note that not all international travel warrants individuals to try to move their 

circadian sleep/wake rhythm. For example, the adaptation will be zero or negligible in fast 

turnaround situations where individuals stay at their destination less than 24 hours before 

returning to the home time zone. If individuals stay longer than 48 hours at their destination, 

then adaptation will start to occur. There is a ‘grey zone’ in research knowledge between 24 

hours and 48 hours. It is also generally considered that when operations occur within three time 

zones or less of the home time zone, there is no significant impact due to circadian adaptation. 

1.6. How FAID Quantum accounts for circadian 

disruption caused by trans-meridian changes 

The method used for calculating the hours of work fatigue score when time zone changes apply 

is to calculate the individual hours of work fatigue score for each hour of duty based on the 

individual's current ‘body clock’. 
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An individual's initial ‘body clock’ is based on their starting time zone from the first duty in the 

work schedule, which is established using the difference between UTC and local time where the 

first duty commenced. Adjustments to the ‘body clock’ are then made taking into account the 

rest time and number of time zones crossed. 

1.6.1. FAID Standard BMM 

In the FAID Standard BMM the researchers chose to implement rates that differ by direction of 

travel. 

Adjustment begins at the end of the duty, and the magnitude of adjustments is as follows: 

 1.5 time zones per day when traveling in an Easterly direction 

 2 time zones per day when traveling in a Westerly direction 

 

There are additional rules and exceptions for adjustments being made: 

1. There is no adjustment to an individual's ‘body clock’ when the second of two consecutive 

duties involves a return to the starting time zone of the first duty in the work schedule and 

either: 

a. the rest period between the two duties is less than 36 hours2, or  

b. the time zone difference is three hours or less, and the rest period between the duties 

is less than 48 hours3. 

2. Any duty performed at the rest period location will not prevent rule one (above) being 

applied. The quickest adjustment to the target time zone will be selected beyond 10 time 

zone changes (which is not always the direction of travel). 

When analysing a work schedule, a work history of 15 days is recommended to best correct an 

individual’s current body clock before the start of the Analysis Period. 

When displaying analysis results, if there is a difference of more than three hours between the 

starting time zone of a duty and the previous duty’s ending time zone, then no FAID Score 

Outputs will be displayed for 15 days after the end time of the previous duty. This action is to 

provide time for the circadian sleep/wake rhythm adaptation to the new time zone, in 

response to the absent time zone movement information. 

1.6.2. FAID Quantum BMM 

In the FAID Quantum BMM the researchers chose to implement resynchronisation expressed 

as 50% of the remaining difference between ‘body clock’ and local time adjusts every 48 hours. 

When analysing a work schedule, a work history of 15 days is recommended to best correct an 

individual’s current body clock before the start of the Analysis Period. 

 
2   A mid-point of 36 hours has been used within FAID Standard BMM to reflect the length of time when circadian disruption begins to occur when the 

second of two consecutive duties returns to the starting time zone of the first duty, to accommodate the ‘grey zone’ in research knowledge between 24 

hours and 48 hours. 

3 Recognising that circadian adaptation is less likely to occur when the time zone difference is three hours or less. 
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1.6.3. Comment on differences 

While these two methods seem quite different, in most cases they lead to differences in 

assumed ‘body clock’ position, at any given time, of less than 3 hours. This would typically be 

well within the variations seen between individuals and does not lead to significant differences 

in the calculated model scores. 

1.7. FAID Quantum Assumptions and Features 

1.7.1. Assumptions 

FAID Quantum uses duty period start and finish times (in UTC and local time for time zone 

version) as inputs, in determining the work and non-work period to be analysed. In performing 

its analysis of the work period and non-work periods, FAID Quantum does not take into account 

the following considerations: 

• A reduction in opportunity for sleep when commute times are greater than 45 minutes 

between home and work. Hence, FAID Quantum will overestimate the recovery value of 

non-work periods in these circumstances. An organisation may wish to extend the shift 

start and finish time by the amount travelled longer than an hour to account for the longer 

commute scenario or extend the sleep buffer in settings. 

• Short breaks within a duty period as non-work periods. For breaks within a duty 

period to be included as non-work time they need to be at least 4 hours and/or greater in 

duration, and quality sleeping facilities must be available (Dean, Fletcher, Hursh, & 

Klerman, 2007). This means that breaks, such as for meals, are not included as non-work 

time, as short breaks are unlikely to be long enough for recovery sleep to be obtained. 

However, see Section 1.7.3 on Augmentation below. 

• What an individual has actually achieved with regards to recovery sleep during a non-

work period. FAID Quantum formula and factors provide an estimate of the fatigue 

exposure typical of the average person based upon statistics gathered from a large 

sample group. It is not a pure measure of fatigue and cannot by itself give an indication of 

whether an individual is fit for work. In the instance where individuals do not use a non-

work period to obtain the recovery sleep predicted by FAID Quantum then the fatigue 

exposure indicated by FAID Quantum might be quite different from that actually 

experienced by the individual. However, see Section 1.7.4 on Actual Sleep below. 

1.7.2. Prior History or Initial State of an Individual 

At the point of time at which the input data starts there is no information about the prior activity 

of the individual. The individual may have worked many hours or none, they also may have 

transited many time zones or none. 

While the software can commence to calculate scores from the time of the first work period this 

is only valid if there was no work performed in the previous seven days and the person’s ‘body 

clock’ is synchronised with the start location. 

If the person may have performed work in the week prior to the start of the data, it is prudent to 

consider as valid only the results beyond seven days after the start of the data. This is to rule 

out any influence the undocumented work periods might have on the scores in the first week. 

If the person may have changed time zones in the fifteen days prior to the start of the data, it is 

prudent to consider as valid only the results beyond fifteen days after the start of the data. This 
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is to rule out any influence the undocumented time zone changes might have on the scores in 

the first fifteen days. 

By default, the FAID Quantum software will determine the time of the first work period and set 

an analysis start date seven days later (or fifteen days for time zone version). This may be 

changed by the user if prior conditions are known and as appropriate recognising the fifteen and 

seven-day periods described above. 

1.7.3. Augmentation 

When using the flight crew augmentation option within FAID Quantum, breaks during a flying 

duty period can be recognised as a non-work period with the quality of sleep set to ‘Partial’ to 

indicate the less than full quality sleep during in-flight rest periods compared to the higher 

quality of sleep achieved with quality sleeping accommodation on the ground. ’Partial’ is by 

default defined as 50% of normal sleep quality and would normally apply to sleep achieved 

during in-flight rest. Such a selection would require Class 1 Quality Rest facilities to be available 

on the aircraft. 50% has only been populated for demonstration purposes. 

The percentage of sleep quality represented by the ’Partial’ setting needs to be determined by 

the operator and can then be adjusted within the software. It should be noted that good quality 

in-flight rest facilities are essential for “any” quality of sleep to be obtained. An appropriate sleep 

quality setting can be determined through a scientific sleep study and risk assessment process. 

1.7.4. Actual Sleep 

FAID Quantum also provides the option for actual sleep obtained to be considered in its 

calculations, if such data is available. While this enables FAID Quantum to reflect more closely 

the experience of an individual, the results are still based upon a statistical model representing 

the general population response to that sleep pattern and not a prediction of an individual’s 

level of fatigue. This also provides a mechanism for comparing calculated KSS scores for both 

the predicted sleep/wake and the actual sleep/wake data to permit determination of the 

significance of any sleep differences. 

1.7.5. Appropriate Use 

FAID Quantum is an easy product to use when appropriate training is undertaken. The above 

points need to be considered when using FAID Quantum, to ensure its most effective and 

appropriate use in the organisation’s operational context. Please contact us 

(faid@interdynamics.com) if you would like training in the context of use and functionality of 

FAID Quantum. 

We hope that this information assists you as you become familiar with the use of FAID 

Quantum as one element of a Risk-Based Approach to managing fatigue in your workplace.  

The InterDynamics FRMS team.  

mailto:faid@interdynamics.com
http://www.interdynamics.com/fatigue-risk-management-solutions/our-risk-based-approach/
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2. Introduction 

This User Guide incorporates all the functionality of FAID Quantum:   

1. FAID Scores (included); 

2. Karolinski Sleepiness Scale Scores (optional); 

3. Sleep Prediction (optional); 

4. Time Zone - circadian disruption caused by trans-meridian changes (optional). 

NOTE:  If the license you have purchased does not include the above optional outputs, each 

item can be acquired as an upgrade. Please contact InterDynamics for further information. 

2.1. First Time User Instructions 

The first time a user loads FAID Quantum, the user will be taken through a series of screens to 

introduce the background and context of the use of FAID Quantum within an FRMS. Firstly, a 

valid license must be submitted either via file selection, or pasting the license file text. 

 

Figure 2-1 License file prompt for FAID Quantum 

  

1. When entering the license file for FAID Quantum the user can either: 

a. Use the ‘Browse For License File’ button to select a license file, or 

b. Copy and Paste the text via the ‘Paste Clipboard Text’ button. 

 

 

Figure 2-2 FAID Quantum opening screen 

 



 

 FAID Quantum User Guide Page 18 of 137 

2. Once the user has submitted a valid license they can then click the Enter button. 

3. The next screen provides an Introduction to FAID Quantum and Fatigue Risk 

Management, click the Continue button. 

4. A series of Tolerance Level (TL) related screens are presented, the first asks whether 

the user wishes to go through a detailed explanation of setting Tolerance Levels, click 

Yes, or click No to skip the explanation and go straight to setting TLs (or setting them 

later). 

 

 

Figure 2-3 No Tolerance Level detected screen 

If the user clicks No, the FAID Quantum Control Panel and Input Screen for Work Schedule 1 

will appear (effectively launching the user into the programme and data entry). However, if the 

user clicks Yes, the following screens will appear giving an overview of Fatigue Hazard Analysis 

and Tolerance Levels. These screens are displayed the first time that FAID Quantum is opened. 

The bullet point list offers additional Information on Fatigue Hazard Analysis and can be 

reviewed at a later date by clicking the Information  button on the Input Control Panel and 

selecting  from the drop-down menu in the Information section. 

  

Figure 2-4 Fatigue Hazard Analysis Information 
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5. Once the user is familiar with the concept and has clicked the Go to Input Tolerance 

Thresholds   button, the following screen appears. 

 

Figure 2-5 Additional information on Tolerance Level and Compliance Targets 

6. Additional information on Setting Tolerance Thresholds is available by clicking on the 

links in the bulleted list.  

7. Once the user is satisfied that they understand the Tolerance Level Threshold concept, 

clicking Yes presents the user with a screen where they can either Select TL Later 

(Skip TL), load a Sample Task Tolerance Level (TL) via the button   or Manually 

Edit the Tolerance Level (TL) by clicking in the cells.  

 

8. To manually edit the TL, click on the words “To Set a Tolerance Level Click here”. 

  

Figure 2-6 Setting Tolerance Levels Screen 

9. A dialogue box to manually edit the TLs is displayed.  
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10. Enter the desired FAID Score Tolerance Level and KSS Tolerance Level then click 

the Start Using FAID   button. 

 

11. After being informed that a KSS Tolerance Level and a FAID Score Tolerance Level has 

been set, click OK. 

Should the user not set an FTL or KTL, the following warning will appear:   

 

Clicking Yes or No will have the following outcomes:   

1. Yes (Click Yes to set no FTL):  the work schedules wil be analysed but will not be 

compared to an FTL. 

2. No (Click No to proceed with FTL = zero):  in the work schedule, every hour worked 

will be above the FTL. 
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3. Control Panel 

 

The FAID Quantum Control Panel is permanently situated on the 

left-hand side of every screen. The Control Panel is divided into two 

areas: 

• Inputs tab – includes all the functionality for entering data; 

and 

• Outputs tab – where the user can retrieve, save and print 

analysis results. 

The tab that is active is always shown as orange and the inactive 

tab is shown as grey. 

The Inputs tab has sections relating to information that will be 

entered on:  

• Tolerance Level (Information and setting parameters such as 

FAID Score and KSS Tolerance Levels);  

• Schedule (Work Schedules, Sleep Schedules, External 

Result);  

• Admin (settings); and 

• Analysis Details (analysing the data) 

The Outputs tab has sections relating to analysis of the information 

entered: 

• Summary 

• Schedule 

• Individual Score  

• Utilisation 

3.1. Help  

Help can be accessed via: 

 

Contextual Help: Click on  found above the Outputs tab 

on the Control Panel to open the Help Document to the 

section relating to the function being used. 

 

Help: The Help Menu provides access to:  

• A Help Document (includes detailed information 

regarding terms, concepts and process steps), 

• User Guide (internet access required),  

• Online Support Documents (internet access 

required),  

• Email Support (internet and email account required), 

and  

• About Application - information relating to the 

Application 
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3.2. License 

  

 

License: The License Menu provides access to read in a 

License Key file via the ‘Get License Key’ selection. 

 

 

 A browse for License file display will appear: 

 

Figure 3-1 License file prompt for FAID Quantum 

 

When entering the license file for FAID Quantum the user can either: 

a. Use the ‘Browse For License File’ button to select a license file, or 

b. Copy and Paste the text via the ‘Paste Clipboard Text’ button. 
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4. INPUTS Tab – Tolerance Level 

4.1. Information 

  

There are a number of important information screens which 

can be accessed by clicking the Information  button on 

the Inputs. 

 

In the dark gray Information section of the Control Panel, 

the user can select from four options: 

• Conditions; 

• FAID Score; 

• Hazard Analysis; and 

• KSS 

 

4.1.1. Conditions 

The Conditions screen contains information on how the red, yellow and green conditions are 

categorised for both FAID Score and KSS. 

 

4-1 Conditions overview 
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4.1.2. FAID Score 

The FAID Score screen gives an overview of the different levels of fatigue exposure. 

 

4.1.3. Fatigue Hazard Analysis 

The Fatigue Hazard Analysis screen provides detailed explanations of InterDynamics’ Fatigue 

Hazard Analysis risk assessment process and its relation to the use of FAID Quantum in the 

setting of Fatigue Tolerance Levels. 

Each of the following bullet points listed on the Fatigue Hazard Analysis screen provides further 

information: 

• The definition of a ‘Fatigue Hazard’; 

• What makes InterDynamics’ Fatigue Hazard Analysis (FHA) process different from most 

risk assessments; 

• Why a FHA is the best way to determine hours of work Tolerance Thresholds (including 

appropriate Fatigue Tolerance Levels and Target Compliance percentages); and 

• Outcomes of a Fatigue Hazard Analysis and further information. 
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4.1.4. KSS 

The KSS screen contains information on the Karolinska Sleepiness Scale (KSS). 

 

4.2. Tolerance Thresholds 

4.2.1. Setting Tolerance Levels (TL) and Target Compliance % 

Having a Tolerance Level provides a benchmark for comparing the individual FAID Scores, 

KSS scores and minimum Sleep, while the Target Compliance % sets a target for compliance to 

the determined FAID Score Tolerance Level (FTL) and KSS Tolerance Level (KTL).  

  

 

 

 

 

1. Click on the Inputs tab on the Control Panel to access the 

Inputs options. 

2. In the Tolerance Level section, click on the Tolerance 

Thresholds   button.  There are three Tolerance 

Editing Screens: 

• KSS  

• FAID Score 

• Sleep 

3. The KSS Tolerance Thresholds screen will be displayed 

with an overview of the thresholds and measures by which 

FAID Quantum can assist in managing hours of work 

related fatigue risk. We recommend all users to note the 

bullet points containing linked information on how best to 

determine and apply them.   

4. The middle section of the Control Panel will allow 

Tolerance Editing.  Set a single Fatigue Tolerance Level 

by selecting the One Only radio button on the Tolerance 

Editing section of the Inputs tab. 

5. Left click into the white KSS Tolerance Level field box and 

type in the KSS Tolerance Level desired followed by the 

Enter key.   
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6. Set the Target Compliance % by left clicking into the 

Target Compliance field box and type in the % value 

followed by the Enter key. The default Target Compliance 

% is set at 98%. 

7. If in Settings – Outputs Two Levels are selected, then a 

Yellow Target Compliance % can be set. Default 95%. 

 

 

8. Set the FAID Score Tolerance Level by selecting FAID 

Score from the drop-down menu.  Then left click into the 

white FAID Score Tolerance Level field box and type in 

the FAID Tolerance Level desired followed by the Enter 

key. 

 

9. Set the Target Compliance % by left clicking into the 

Target Compliance field box and type in the % value 

followed by the Enter key. The default Target Compliance 

% is set at 98%. 

10. If in Settings – Outputs Two Levels are selected, then a 

Yellow Target Compliance % can be set. Default 95%. 

 

11. Set the Sleep Tolerance Level by selecting Sleep from 

the drop-down menu.  Default values for 24 and 48 hours 

are provided but these can be amended by left clicking in 

the appropriate field box, entering the required value 

followed by the Enter key.   

Conducting analysis using a single TL for both KSS and FAID Score is generally recommended 

for initial users to compare groups of individuals performing like-risked tasks. Subsequent 

analysis on groups of individuals identified as having a different set of task risk factors can be 

done at a higher or lower FTL as appropriate.  

NOTE:  There is the opportunity to load a Sample Tolerance Level by clicking on the Load 

Sample FTL (or KTL or STL)  button. 

NOTE: When Settings > Inputs > Display > Include Task Risk = NO, only the No FTL or KTL 

and One FTL or KTL choices will be available in the Tolerance Editing options. The default 

setting is for No Task Risk to be included in the Work Schedule details. If the user would like to 

include a Task Risk for hours of work in Work Schedule information, they can change the 

“Include Task Risk” section within Settings to Yes. Task Risk is needed when using Multiple 

Tolerance Levels.  
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Risk Assessment processes such as InterDynamics’ Fatigue Hazard Analysis risk assessments 

assist in the capture and analysis of data required to set meaningful Tolerance Levels and 

compliance targets for selected jobs or tasks. 

The following represents an example of a combination of hours of work rules that could fit within 

an organisations’ FRMS guidelines, utilising FAID Quantum as a key component in the 

development and audit of fatigue risks associated with hours of work: 

• FAID Score Tolerance Level (FTL) / KSS Tolerance Level (KTL) or Sleep Tolerance 

Level (STL) of 'x' (or multiple FTLs or KTLs for tasks of various risks)  

• Monthly, or roster cycle period compliance of all hours to be no less than 'y'% (Target 

Compliance)  

• Individual shifts should not exceed 'z' points above the FTL or KTL 

• Varying levels of actions/controls to be applied as exposures approach/exceed FTL or 

KTL 

• Potential for differing values of x, y, and z above, for planned hours as opposed to actual 

hours  

 

NOTE:  The Tolerance Levels are always displayed at the bottom of all screens.  

   

 

IMPORTANT:  The Tolerance Levels you apply is your responsibility. 

https://www.interdynamics.com/fatigue-risk-management-solutions/fatigue-risk-management-services/fatigue-hazard-analysis-risk-assessments/
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5. First-time users can review a Sample 

Work Schedule 

  

1. Click on the Inputs tab within the FAID Quantum Control 

Panel to access the Inputs options.  

2. In the Work Schedule options, click on the Work 

Schedule    button.  

3. A blank Work Schedule screen appears which will have 

the following headings across the top of the screen: 

 

 

4. Click on Load Sample Work Schedule  in the 

Input Table Editing options. 

5. Analysing the Sample Work Schedule:  Once the Sample Work Schedule has been 

loaded the user can run an analysis on the Work Schedule and compare output results.  

NOTE:  To be effective FAID Quantum requires seven days of data as history to be entered 

before meaningful analysis can begin. 

 

6. Click on the Date and Period Wizard   button. This 

ensures analysis will pick up latest Work Schedule data and 

automatically sets the Start Date and History From Date 

fields, ensuring seven days of work history before Start 

Date. 

7. Click on the Analyse  button. 

NOTE:  If the user is only interested in analysis of a subset of the data, in the Analysis Details 

options, do not click the Date and Period Wizard button either: 

a. With Settings Select Last Date for Analysis = No; change the Period weeks to be 

analysed (e.g. with the sample work schedule, the user could change Period from 4 

weeks to 2); or  

b. With Settings Select Last Date for Analysis = Yes; change the Last Date of the analysis 

period (e.g. if looking at the sample work schedule with Start Date 2 July, the user could 

change Last Date from 26 July to 16 July). 
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Also, the user can click on the Lock Date  button to lock 
the Analysis Details. 
 

The Lock Date  icon will appear to indicate the Analysis  
Details will not change, unless the user manually edits a Date 
cell, or uses the Date and Period Wizard button. 
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6. INPUTS Tab – Admin 

6.1. Settings 

In FAID Quantum, Settings editing is divided into different sections which can be selected from 

the drop-down menu: 

1. Inputs 

2. Analysis 

3. Outputs 

4. Views 

5. Aviation 

6. Activity Task 

6.1.1. Inputs 

 

On the Inputs tab in the Admin section click on the 

Settings  , button and select Inputs from the drop-

down menu, the following Schedule and Add Details 

Settings screen will be displayed.  

 

 

Figure 6-1 Inputs Settings Screen 

 

6.1.1.1. Formatting 

1. Identification:  This allows the user to use “Name” (text), or “ID” (value), which allows 

sorting of the names alphabetically or the IDs numerically. 

2. Date:  The date format used within FAID can be selected between 

DD MMM YY HHMM, MMM DD YY HHMM and YYY MM DD HHMM. 
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6.1.1.2. Read File 

1. Remove Zero ID: Set Yes to remove any work periods with a value of zero. The default 

for this Setting is No. User will be notified of number of work periods removed.  

2. Remove Zero Times: Set Yes to remove work periods where the Start or End times have 

a zero value. The default for this setting is No. User is notified of number of work periods 

removed.  

3. Remove Zero Work: Set Yes to remove work periods where no work is performed; Start 

Time equals End Time. The default for this setting is No. User is notified of number of 

work periods removed. 

4. Remove One Work Period: Set Yes to remove IDs that only have one work period in the 

schedule. The default for this setting is No. User is notified of number of work periods 

removed.  

5. Remove Duplicate:  The default for this Setting is No. Options are No, Exact, Pattern. If 

you would like exact duplicate work periods removed, the user can change the setting to 

Exact so that the duplicate work periods are removed. Should the user import a work 

schedule with multiple individuals working exactly the same work periods, the user can 

change the setting to Pattern so that the duplicate work patterns are removed, thus 

individuals, during the importing of a work schedule, and only one individual working the 

work pattern will remain. 

6. Remove Header Row: Select Yes or No by clicking in cell. If set to YES, the first row in 

the imported Work Schedule will be ignored. 

7. Option for All Files in Folder: Select Yes or No by click in cell.  If set to YES, when the 

user selects to load in a file to the Work Schedule, then if any other files with the same file 

extension are present in the selected folder, they will also be imported and appended to 

the Work Schedule.  Useful for importing multiple individual work schedules to create a 

combined work schedule. 

8. .csv for Spreadsheet Style: Options are Yes or No and the following parameters apply: 

a. No:  When importing a .csv file into a Work Schedule, the file will be read as a 

normal work schedule, i.e. comma separated format. 

b. Yes: When reading, or importing from clipboard, a Work Schedule file FAID 

Quantum will be looking for the format of first field, ID# (or Name), then all fields 

to the right are read as shift codes.  If the shift code is not found in the shift code 

table, then the import stops and the user is informed to update the shift code 

table. 

 

9. Lock Analysis Date: Options are Yes or No by clicking in cell. If set to YES, the Analysis 

Detail Dates will not automatically change due to editing of the Work Schedule. Only 

editing the cells or using the Analysis Wizard button will change dates. In the Analysis 

Details section on remove control a ‘lock’ icon  will appear.  
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6.1.1.3. Work Schedule Display 

1. Include Task Risk:  Whilst FAID Quantum enables users to select different task risks for 

each work period, most FAID Quantum users initially evaluate all work periods in a Work 

Schedule against a single Tolerance Level (TL) thereby not requiring Task Risk ratings. 

Click to select Yes to enable the use of multiple Tolerance Levels.  

Default Task Risk: This field is only displayed if Include Task Risk is changed from No 

(default) to Yes. The Default Task Risk is displayed in the Work Schedule if a Task Risk 

has not been nominated. The task risk level for each work period can be changed by 

clicking through Low, Moderate and High. 

2. Include Activity: Displays an additional column in the Work Schedule listing the Activity 

Details for each shift. Click in the cell to change to No which will remove this column. 

3. Include Locations: If set to Yes, additional columns for Origin and Destination locations will 

be added for each shift 

4. Include Sleep Buffers:  If set to Yes, additional columns for Prior Sleep Buffer and Post 

Sleep Buffers will be added for each shift.   

5. Include Post Shift Rest Quality:  Displays an additional column in the Work Schedule 

listing the post shift rest quality. This allows the insertion of possible in-flight rest as well as 

nominating the quality of rest period as only Partial (as default is Full). This can be used 

when planning or assessing an actual roster to determine the impact of in-flight sleep 

augmentation.   

 

NOTE: When No Task Risk has been included (from Settings), only No TL or One TL choices 

will be available in the Tolerance Level (TL) section. 

NOTE:  If Include Task Risk is set to Yes, when importing or copying a Work Schedule or Sleep 

Schedule into FAID Quantum, then an additional field with a Task Risk against each shift must 

be included in the data to be imported (with each shift labelled as either Low, Moderate or High 

Task Risk). 

 

6.1.1.4. Work Schedule Mode 

1. Use Time Zone Details: The default = Yes however, should the user choose to analyse 

work hours when time zone changes are insignificant (i.e. less than 3 hours), then changing 

Yes to No will result in the user only entering Start and End times and no time zone 

movement is used during analysis and is not recorded in outputs. When Selecting No a 

popup warning will inform the user that UTC Start and End Times will be overwritten with the 

corresponding Origin and Destination Times. NOTE: this change cannot be undone. 

 

 

6.1.1.5. Sleep Schedule Display 

1. Perform Sleep / KSS Analysis:  The default is Yes, click to change to No 
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6.1.1.6. External Result Display 

1. Import External Results: If set to Yes, allows the user to add an extra schedule of External 

Results, to be included in the Outputs to compare with the analysis results. When set to Yes 

the navigation button to External Result will appear on the Remote Control. 

2. External Results Format: This allows the user to use value, or text, for describing the 

external result. 
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6.1.1.7. Shift Types 

 

 

Add Shift Screen - Settings  
Use Time Zone Details = Yes 

  

Add Shift Screen - Settings  
Use Time Zone Details = No 

Shift Types:  Default shifts can be created for ease of use 

when adding shifts in the Work Schedule Edit screen,  

these will be referenced in the Display of Shift Types in 

Outputs. 

 

The reports in Outputs are set to look for shifts matching 

the Start/End times of the default Shift Types set here.  

 

 

 

To Add Shift Types: 

1. Click on the Add Shift to Shift Types  button in 

the Settings Editing section of the Control Panel. 

 

2. In the Add Shift window enter Description, Code, Start 

Time of Day and Length of Shift.  FAID Quantum 

automatically calculates the End Time of Day. 

 

3. Select a Text Colour and Background Colour. 

  

 

4. Click on Submit.  

 

 

5. If there are a range of different Shift Types for different 

departments within an organisation, Shift Types can 

be created and copied in a spreadsheet and pasted 

using the paste from clipboard  button, or saved 

as a .dat file and loaded for use by clicking the save 

 and load  buttons. 
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6.1.1.8. Individual List 

 

Individual List: If the format for the Individual Identifier is 
Name (Text) then when work schedules are entered, or 
manual entering, the names are saved to a list. If the lsit 
becomes too long there is an option to delete the entire 
list.   
 

 

6.1.2. Analysis 

 

On the Inputs tab in the Admin section click on the Settings  

, button and select Analysis from the Settings Editing drop-

down menu, the Analysis Settings screen will be displayed.  

  

Figure 6-2 AnalysisSettings Screen 

 

1. Perform FAID Score Analysis:  The default is Yes, click to change to No. 

2. Perform Sleep / KSS Analysis:  The default is Yes, click to change to No. 

3. Sleep Buffer:  The Sleep Buffer specifies when an individual can start sleeping after 

working, the default for Normal is 1 hour, and the default for Short is 30 minutes, and the 

default for Long is 2 hours , i.e. if the individual finishes at 0700, and the Sleep Buffer is 

1hr, then the earliest time a sleep onset will be predicted is 0800. 

If in Settings – Inputs the Include Sleep Buffers is set to No, then only the Normal Sleep 

Buffer will be displayed. 

4. Generate Missing Historic Sleep: The default is No, click to change to Yes. If an 

individual only works in the Analysis Period, then the Sleep Prediction will only start after 

first shift. If Yes, Sleep Prediction will occur in the History Period. 

5. Analyse Wizard set closest:  The analysis wizard can be configured to reflect analysis 

up to a particular day of the week to enable consistent comparisons to a certain date. If 

analysis up to a certain date is required, this feature can be activated here, alternatively 

analysis to a month rather than day can be selected. The default is for FAID Quantum to 
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find the earliest Start Time and set the Start Date seven days forward (to allow for work 

history).  

An additional function when running an Analysis is to set the Start Date 

 which can be set seven days forward and FAID Quantum will then 

find the nominated closest day (useful for clients who start roster rotations on specific 

days). 

6. Select Last Date for Analysis:  The default is Yes, which displays a date for the end of 

the analysis in Analysis Details instead of defining the analysis period in weeks. This can 

be used if the analysis needed is only for a specific month). 

7. Lock Analysis Date: Options are Yes or No by clicking in cell. If set to YES, the Analysis 

Detail Dates will not automatically change due to editing of the Work Schedule. Only 

editing the cells, or using the Analysis Wizard button will change dates. In the Analysis 

Details section on remove control a ‘lock’ icon   will appear). 

8. Outputs only when Start Time in Analysis period:   Outputs only displayed if the Start 

Time is after the Start Date in Analysis Details. Useful for investigating a specific month 

(or period) for a work schedule.  

  



 

 FAID Quantum User Guide Page 37 of 137 

6.1.3. Outputs 

 

On the Inputs tab in the Admin section click on the Settings  

, button and select Outputs from the Settings Editing drop-

down menu, the Outputs Settings screen will be displayed. 

   

Figure 6-3 Outputs Settings Screen 

6.1.3.1. Summary  

1. Risk Profile – Individuals:  On the Outputs tab in the Summary section, in the Display 

Options one of the options is to display Risk Profile for both FAID Score and KSS (see 

Outputs Section 9.1.10 for more information).  One aspect of the Risk Profile is the four 

Compliance % Bands (e.g. default listing is top to bottom 0, 90, 95, 98, 100). These bands 

can be modified as required here in the Outputs section of Settings. 

2. Calculate Apparent TL using Compliance % of:  In the Outputs tab under Summary, 

Display Options can provide the Apparent TL, representing the compliance of each 

individual and an overall Work or Sleep Schedule compliance for different TLs ranging from 

zero to highest needed to achieve 100% compliance, with a highlighted display of the TL 

when overall 98% compliance is achieved. By default, the ‘Apparent’ Tolerance Level 

represents the FAID Score or KSS score at which 98% of the hours analysed are less than 

(or within). Hence, a higher ‘Apparent’ TL indicates higher fatigue exposure for the hours 

analysed. This view is similar to that seen when No TL is chosen in Inputs. When six to 

twelve months of actual hours of work are analysed, the Apparent TL indicates the level of 

hours of work-related fatigue risk that the organisation has been tolerating 98% of the time 

(using default settings). It also defines a point from which to begin investigating business 

processes that resulted in the outlying 2% of hours (under this scenario), and informing 

decisions around the setting of TLs. If Compliance at a different percentage is sought, the % 

can be changed in this field. 
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3. Display Apparent TL in Key Risk Indicators (KRI): The default setting is No. In the 

Outputs Key Risk Indicators for the Compliance display, the Apparent TL for the overall 

summary as well as each individual in the work schedule will be displayed when set to Yes.  

4. Display Target Compliance %: The default setting is No, however the user can choose to 

not display Compliance % by clicking to Yes. The Target Compliance percentage will be 

displayed in the Summary for Hours at Result, and also the Dashboard view. 

a. Two Levels: Is the percentage close to the Target Compliance for the Yellow 

indicator dot on Dashboard display. Click in the cell to change the percentage 

value. Default is No. 

5. Hours at FS Block: For the Display ‘Hours at Result’ the user can change the block 

increments used for the hours worked in each FAID Score block. The default is 10. 

6. Hours at KSS Block: For the Display ‘Hours at Result’ the user can change the block 

increments used for the hours worked in each KSS Score block. The default is 1.0 . 

 

6.1.3.2. Schedule 

1. Export Condition Times as x.x hours: The default setting is No, if changed to Yes, then in 

the Outputs when copying to clipboard, or saving to file, the FAID Score and KSS Condition 

times will be saved as values (ie 2.5 instead of 2hrs 30mins). Useful for importing into 

spreadsheets for display. 

2. Display Predicted Sleep Less than 10min: The default setting is No, however the user 

can choose to display predicted sleep which is less than 10 minutes in length. 

3. Ignore Sleep Cond when Past 168hrs Sleep is Zero: The default setting is Yes, if 

changed to No, then in the Outputs the Condition highlight will occur even if in the past 168 

hours there has been no sleep (ie first work period without prior sleep prediction). 

6.1.3.3. Condition Display 

 

1. Cond Show: The user can select to change the Condition highlight in the Output Schedule 

depending on the highest Condition achieved. Click in cell to change Yes or No (default is 

No). 

• PFS Cond Show = Peak FAID Score Condition highlight cell 

• PKSS Cond Show = Peak Karolinska Sleepiness Score Condition highlight cell 

• Sleep Cond Show = Sleep Prior 24 and 48 hours Condition highlight cell 

2. Cond Green Show: If the user is displaying the Condition highlight then the user can also 

select to not show the Green Condition highlight in the Output Schedule. Click in cell to 

change Yes or No (default is No) 

• PFS Cond Green Show = Peak FAID Score Green Condition highlight cell 

• PKSS Cond Show = Peak Karolinska Sleepiness Score Green Condition highlight cell 

• Sleep Cond Show = Sleep Prior 24 and 48 hours Condition Green highlight cell 
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6.1.3.4. Plot Displays 

1. Colour by Peak FAID Score Condition:  When viewing Output plot displays the user can 

determine whether or not the Peak FAID Score Conditions (red/yellow/green) are displayed 

(default setting is Yes).  If the default is changed to No, the plot display colour (black) shows 

the FAID Score and the Yellow and Red Tolerance Level is displayed. 

2. Colour by Peak KSS Condition: When viewing Output plot displays the user can 

determine whether or not the KSS Conditions (red/yellow/green) are displayed (default 

setting is Yes).  If the default is changed to No, the plot display colours are represented 

simply as working or non-working hours. 

6.1.3.5. Multiple Shifts Roll-up 

 

The user can set the minimum non-work period being used in a roll-up, e.g. if the user has 4 

hours in the settings and there are three shifts 

• 0800-1000 

• 1030-1200 

• 1800-2100 

the roll-up would be 0800-1200 and 1800-2100 because the non-work between 1200 and 1800 

is greater than the 4hrs. Multiple Shifts Rolled-up are indicated in the far left hand column of 

Work Schedules and the FAID Score Table output screens by a + symbol. 

The user has the ability to describe/select the description for the rolled-up shifts.  Options are: 

• Multi 

• Pairing 

• Rollup 

 

6.1.3.6. Utilisation 

 

Shift Types:  Default shift types can be created for ease of 

use when adding shifts in the Work Schedule Edit screen 

and these will be referenced in the Shifts Types display in 

Outputs. 

The reports in Outputs are set to look for shifts matching 

the Start/End times of the default Shift Types set here. If 

the shift Start/End times do not match exactly with the 

default Shift Types, the reports in Outputs can be set to 

classify the shifts to the most appropriate Shift type by 

either Start Closest to Detail Start Time, or Start 

>=Detail Start Time via the dropdown menu. 
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Add Shift Screen - Settings  
Use Time Zone Details = Yes 

 

  

Add Shift Screen - Settings  
Use Time Zone Details = No 

 

 

 

 To Add Shift Types: 

1. Click on the Add Shift to Shift Types  button in 

the Settings Editing section of the Control Panel. 

2. In the Add Shift window enter Description, Code, Start 

Time of Day and Length of Shift.  FAID Quantum 

automatically calculates the End Time of Day. 

3. Select a Text Colour and Background Colour. 

4. Click on Submit. 

 

 

 

If there are a range of different Shift Types for different 

departments within an organisation, Shift Types can be 

created and copied in a spreadsheet and pasted using the 

paste from clipboard  button, or saved as a .dat file 

and loaded for use by clicking the save  and load  

buttons. 
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6.1.3.7. Activity Details 

 

The Activity Details colours can be edited to suit the user. 

When a Work Schedule is analysed the Fatigue Gantt Chart can 

be viewed by shading according to FAID or KSS Condition 

(shaded green, yellow or red) or according to Activity, or a 

combination of FAID Condition and Activity or KSS Condition 

and Activity.  

Additional Activities can be added or deleted using the using the 

 or  buttons. 

When using the Add In Flight Rest button in a Work Schedule, 

FAID Quantum will only add In Flight Rest to Activities that are 

set Yes in the In Flight Rest column, e.g. the User would not 

want to add In Flight Rest to a Ground Duty that is 8 hours in 

duration (see Section 7.4.9 for further information on In Flight 

Rest and its application).  
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6.1.4. Views 

Sections of FAID Quantum that are not used may be simply hidden from view by un-ticking 

View within the Display area. 

1. On the Inputs tab in the Admin section click on the Settings   button and Select 

Views from the Settings Editing drop-down menu, the Settings will be displayed. 

2. Click on the item in the View column to either display or hide Inputs and Outputs options. 

  

 

Figure 6-4 View Settings Screen 
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6.1.5. Aviation 

 

On the Inputs tab in the Admin section click on the Settings   

button and Select Aviation from the Settings Editing drop-down 

menu, the Settings will be displayed. 

 

Figure 6-5 Aviation Settings Screen 

6.1.5.1. Airports 

Airport codes are pre-loaded for use in Work Schedules when adding new shifts. A filter can be 

used by clicking on the * at the top of the column for, say, Country. Select from the drop-down 

menu and then for each Airport with an IATA_FAA code, click Yes in the Available for Add 

Shift. When adding a shift, only those airports with Yes in the Available for Add Shift will be in 

the drop-down menu for Origin and Dest. Additional Airport Codes can be added when editing 

the Work Schedule and can be deleted from the Airport Codes selection by right clicking on the 

number in the far left column and selecting delete row. 
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6.1.5.2. Activity Details 

 

The Activity Details colours can be edited to suit the user. 

When a Work Schedule is analysed the Fatigue Gantt Chart can 

be viewed by shading according to FAID or KSS Condition 

(shaded green, yellow or red) or according to Activity, or a 

combination of FAID Condition and Activity or KSS Condition 

and Activity.  

Additional Activities can be added or deleted using the using the 

 or  buttons. 

When using the Add In Flight Rest button in a Work Schedule, 

FAID Quantum will only add In Flight Rest to Activities that are 

set Yes in the In Flight Rest column, e.g. the User would not 

want to add In Flight Rest to a Ground Duty that is 8 hours in 

duration (see Section 7.4.910 for further information on In Flight 

Rest and its application).  

6.1.5.3. Apply In Flight Rest 

 

 

 

1. In FAID Quantum, the Apply In Flight Rest 

function allows the insertion of possible in flight 

rest periods and nominates the rest quality as 

“partial” (see Section 7.4.910 or further 

information on In Flight Rest and its application).  

 

 

 

 

 

 

 

2. In Flight Rest Button:  The default setting is No, 

however, if the user is using the Time Zone 

functionality, selecting Yes will activate an icon 

 in the Input Table Editing which will Add 

Inflight Rest.  

 

 

Please Note: “Partial” is defined as 50% of normal sleep quality and would normally apply to 

sleep achieved during in-flight rest. Such a selection would require Class 1 Quality Rest facilities 

to be available on the aircraft. 50% has only been populated for demonstration purposes. The 

percentage of sleep quality represented by the “Partial” setting needs to be determined by the 

operator and could then be adjusted within the software. It should be noted that good quality in-

flight rest facilities are essential for “any” quality of sleep to be obtained. An appropriate sleep 

quality setting can be determined through a scientific sleep study and risk assessment process. 
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The rules for in-flight rest are based on the total time available for in-flight rest (assumed to be 

one hour after departure until one hour prior to landing). The Default Settings are set to 

calculate: if the crew has three pilots, the total time available for in-flight rest is divided by three. 

If the crew has four pilots, the total available in-flight rest is divided by two.  

 

The assumptions are that the individual pilot’s available in-flight rest period is right in the middle 

of the total available time for rest.  

Example:  Based on 3 pilots, all times in GMT 

 Depart city A: 1900 / Arrive city B: 0600 – 11 hours flight duty 

1 hour taken off at each end of flight, total time available for rest: 9 hours 

Time available for each pilot: 3 hours 

Place 3 hours of available in-flight rest from 2300 to 0200 

 

These settings can be adjusted to suit the User’s flight operations. 

6.1.6. Activity Tasks 

     

When Multiple Tolerance Levels have been set (see Section 4.2) specific task risks can be 

applied to Activities during import.  For example, if shifts with the Code GD (ground duties) are 

imported a Low Task Risk can be allocated to those shifts.    

Specific activities (e.g. Standby), can have a portion of those hours removed (either from the 

start and/or end), during the importing of the Work Schedule.    

6.1.7. Version Reference 

  

In the Settings section the user can view the version of 

FAID Quantum currently installed. This is found below the 

Analyse button on the Settings Screen. This can assist 

when checking whether the user is up-to-date with the 

latest version and with support calls. 
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7. INPUTS Tab – Schedule 

There are three options for Schedules, Work Schedules  , Sleep Schedules  and 

External Result Schedules .  All Schedules have the ability to load two schedules, for 

example: 

• Work Schedules – Work Schedule 1 for Planned and Work Schedule 2 for Actual 

• Sleep Schedules – Sleep Shedule 1 for Predicted sleep and Sleep Schedule 2 for Actual 

sleep. 

• External Results Schedules – External Result Schedule 1 for Work Schedule 1 and 

External Result Shedule 2 for Work Schedule 2. 

When FAID Quantum is first loaded all schedules are blank and there are a number of options 

for adding data: 

Work schedules: 

1. Reading an existing file (file types supported are .fqw, .rtq, .rtr, .rtz or a comma separated 

spreadsheet database (.csv) file). (see Section 7.1.1 for detailed explanation of this 

process); 

2. Pasting from the Clipboard (see Section 7.1.3 for detailed explanation of this process);  

3. Directly input via Add Shift function (see Section 7.1.6) or  

4. Copying Work Schedule 1 to Work Schedule 2 (see Section 7.1.2 for a detailed 

explanation of this process). 

Sleep schedules 

1. Reading an existing file (file type supported .fqs, .slp or a comma separated spreadsheet 

database (.csv) file ) (see Section 7.2.1 for detailed explanation of this process); or 

2. Pasting from the Clipboard (see Section 7.2.2 for detailed explanation of this process). 

NOTE:  All Sleep Schedules must have a corresponding Work Schedule, however if a Work 

Schedule is loaded without a corresponding Sleep Schedule, FAID Quantum will create a 

“predicted” Sleep Schedule during the analysis process. 

External Result schedules: 

1. Reading an existing file (file type supported .fqr, or a comma separated spreadsheet 

database (.csv) file ) (see Section 7.3.1 for detailed explanation of this process); or 

2. Pasting from the Clipboard (see Section 7.3.2 for detailed explanation of this process). 

NOTE:  All External Result Schedules must have a corresponding Work Schedule. 
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7.1. Work Schedule 

7.1.1. Work Schedule - reading an existing Work Schedule file 

 

 

When users regularly analyse and compare data, they will 

have FAID Quantum Work Schedule files previously stored 

on their system. Users can import or load this data back into 

FAID Quantum to allow new data to be added to the Work 

Schedule or for further analysis.  

 

1. On the Inputs tab in the Input Table Editing select 

either Work Schedule 1 (or 2) from the drop-down View 

menu. Click on the Read Work Schedule from File 

 button to load a previously saved Work Schedule 

into FAID Quantum. 

2. In the Select File to Read dialogue box, the default file 

type will be FAID Quantum Work Schedule (*.fqw), 

clicking the drop-down arrow will allow this file type to be 

changed to *.rtq (FAID Quantum v1.0 format), *.rtr (FAID 

- Business work schedule), *.rtz (FAID – Business (Time 

Zone) work schedule); or All Files to locate an alternate 

file type (a comma separated file, .csv).  Locate and 

select the required File.  

3. Click the Open button.  

4. The selected Work Schedule file is loaded onto the Work 

Schedule screen. 
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7.1.2. Adding a Second Work Schedule 

 

1. FAID Quantum offers the option to add a second Work 

Schedule to enable analysis comparisons, for example 

when Work Schedule 1 contains planned shifts and Work 

Schedule 2 contains actual shifts worked. 

2. In the Input Table Editing section of the control panel, 

Select Work Schedule 2 from the View drop-down menu. 

A blank screen is offered where Work Schedules can be 

imported or created. 

3. Alternatively, by clicking the  button in the Input Table 

Editing menu, Work Schedule 1 can be copied to Work 

Schedule 2 and then modified as required. 

7.1.3. Adding a Work Schedule by copying data 

Users have the option to import a Work Schedule from a spreadsheet/database (e.g. Excel) into 

FAID Quantum onto the Work Schedule screen.    

 

1. In spreadsheet, highlight the cells to be copied and copy to 

the clipboard.   

2. On the Input tab click on the Work Schedule  button 

and in Input Table Editing – View 

select the Work Schedule (1 or 2) from the drop-down 

menu. 

3. In Input Table Editing click on the Paste Clipboard to 

Work Schedule  button. 

4. An information box will display indicating the number of 

rows of data that were imported. Click the OK button to 

continue. 

5. The copied cells are imported onto the selected Work 

Schedule screen/Worksheet. 

 

NOTE: If there are rows of data currently in the Work Schedule 

an Information box will ask to Append to Current Work 

Schedule (Yes / No / Cancel).  

NOTE:  In Settings – Work Schedule, if Include Task Risk is set 

at Yes, a fourth field with a Task Risk (Low, Moderate or High) 

must be included in the data to be imported. 
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7.1.4. Adding Single Work Periods (Time Zone Details) 

NOTE: Only available with FAID Quantum Time Zone version.  

Single mode allows the user to enter the start date and time and the end date and time of a 

single shift for a specific individual and apply it to the Work Schedule by clicking the Add Single 

button. Continued clicking of the Add Single button will replicate the nominated shift plus the 

details in Time Till Next Start (Hours/Minutes). 

  

 

1. Click on the Inputs tab within the Control Panel to access 

the Inputs options.  

 

2. In the Input Table Editing section, select the Work 

Schedule (1 or 2) from the drop-down menu 

 that the Work Period is to be added 

to.  Work Schedule 1 is the default option.   

 

3. In the Input Table Editing options, click on the Add 

Work Schedule Row(s)  button to activate a pop-up 

menu Edit Work Schedule Row(s). The pop-up menu 

has two tabs, Single and Cycle, choose the Single tab. 

 

 

Add Shift Screen – Settings  
Use Time Zone Details = Yes 

 

(NOTE:  Yes has been selected in Settings for Include Post 

Shift Rest Quality, Include Activity and Include Locations) 

 

1. Enter the Name (either the name of the employee or a 

unique identifying code or number). If codes have been 

added, these will appear as a drop-down menu. 

2. Enter the Activity from a drop-down menu – default 

options are briefing, debrief, DH (deadhead), FL (flight), 

GD (ground duty), GDE (ground duty extra) or PAIRING.  

3. Enter the Start UTC (Co-ordinated Universal Time) 

date/time in ddmmyy hhmm format. 

Enter the Origin (IATA Codes) by clicking in the cell and 

then on the scroll arrow to select from menu. NOTE: 

Airport codes are predetermined in the Aviation Settings, 

Section 6.1.5.1 Entering the first couple of letters, e.g. SY 

will jump up or down the list quickly. 
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4.  The TZ (+ or -  UTC) will auto fill, however if this is 

incorrect based on the user’s knowledge, this time can 

be overwritten in the Admin section in the Settings 

Screen – Airport Codes. Changes for daylight saving are 

not taken into account and must be manually adjusted). 

5. The Origin Time field will auto-fill based on the UTC and 

Origin. 

6. Pre-determined shifts (see Section 6.1.1.7)  can be 

selected from the Use Times options. 

7. Enter the End fields as per 3, 4, 5, 6 above. 

8. Select whether Rest is Full (default) or Partial. 

NOTE:  Two categories of sleep quality are currently established, ’Full’ and ’Partial’. ’Full’ is 

defined as 100% of normal sleep quality and would normally apply to sleep that is obtained at 

home or in a hotel bed. In FAID Quantum, ’Partial’ has been defined as 50% of normal sleep 

quality for demonstration purposes only, and would normally apply to sleep achieved during in-

flight rest.  

The percentage of sleep quality represented by the ’Partial’ setting (for demonstration purposes 

50% by default) needs to be determined by the operator, which can then be adjusted within the 

software. It should be noted that good quality in-flight rest facilities are essential for “any” 

quality of sleep to be obtained. 

 9. Enter Next Start hour and minutes, which represents how 

long before the next shift.  

10. Click on the Add Single button to add the entered work 

period details onto the Work Schedule screen. The Start 

Time will change on the Edit Work Schedule display ready 

for adding another shift from after the period indicated in 

the Time till Next Start fields. 

 

NOTE:  Select the dates by clicking in the white cell beside Start and/or End date/time field and 

using the dropdown calendar to select the Day/Month/Year. 

NOTE:  Select the Times by using the four zeros that follow the Day/Month/Year. Up and down 

arrow keys or direct numeric entry may also be used to make selections within each section of 

the cell. The first 00 represents hours and the last 00 represents minutes in a 24-hour clock. 

If Include Task Risk is set to Yes in Settings, after entering the Activity in Step 2, select the 

level of Task Risk    

 

NOTE:   If no Task Risk details displayed in the popup, and the user would like to include a 

Task Risk for Hours of Work in Work Schedule information, in the Settings Options the user can 

change the “Include Task Risk” option to Yes (see Section 6.1.1.3 ).  

NOTE:  Work Periods is a count of the number of work periods in the Work Schedule that auto-

calculates. 
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7.1.5. Adding a Cycle of Shifts (Time Zone Details)  

NOTE: Only available with FAID Quantum Time Zone version.  

 

Add Cycle Screen – Settings 
Use Time Zone Details = Yes 

Include Task Risk = Yes 

 

Follow Steps 1 – 8 for adding a Single Shift,  

 

9. Enter the number of consecutive Days On and Off for the 
cycle. 

10. Click on the Add Cycle button to add the entered work 

period details for the cycle onto the Work Schedule screen. 

Repeated clicking on the Add Cycle button will replicate the 

entered shift cycle details for successive date periods. 

TIP:  Work Periods under Add Cycle enables the user to keep track of the number of work 

periods added. 

NOTE: When using Add Cycle, should the cycle start times change, always check to confirm 

that the next start date is correct, taking into account Days On and Days Off. 
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7.1.6. Adding Work Periods 

NOTE:  This function allows the user to add either Single or a Cycle of Work Periods. 

 

 

1. Click on the Inputs tab within the Control Panel to access 

the Inputs options.  

  

2. In the Input Table Editing section, select the Work 

Schedule (1 or 2) from the drop-down menu 

 that the Work Period is to be added 

to.  Work Schedule 1 is the default option.   

 

3. In the Input Table Editing options, click on the Add 

Work Schedule Row(s)   button to activate a pop-up 

menu Edit Work Schedule Row(s).  

 

 

1. Enter the ID# (either the name of the employee or a unique identifying code or number). If 

codes have been added, these will appear as a drop-down menu. 

2. Enter Shift Start Date  

3. Either: 

a. Select preset Shift Types (eg. Day/Night) on right hand side of pop-up under Use 

Times (see Section 6.1.1.7 to set Shift Types) or, 

b. Enter Shift Start Time and a Shift End Time.  Length of shift will autofill 

(alternatively, enter Start Time and Length and End Time will autofill). 
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4. If a Single Shift is to be added use radio buttons to select Single then enter Time Until 

Next Start.   

5. If a Cycle of Shifts are to be added, change Repeat for Days and Days Off After to 

appropriate numbers. 

 

6. Click Add Shift. 

NOTE:  If Admin > Settings > Inputs > Include Task Risk = Yes, then the following steps 

must be taken  

7. Select the appropriate level of Task Risk from the drop-down options adjacent to the 

Name field. 

 
NOTE:  If no Task Risk details displayed in the popup, and the user would like to include 

a Task Risk for hours of work in Work Schedule information, in the Settings Options the 

user can change the “Include Task Risk” option to Yes (see Section 6.1.1). 

 

8. Click on the Add Single button to add the entered work period details onto the Work 

Schedule screen. The Start Time will change on the Edit Work Schedule display ready 

for adding another shift from after the period indicated in the Time till Next Start fields. 

NOTES:   

a. Repeated clicking on the Add Single button will replicate the entered shift details 

for successive dates. 

b. Select the first date by clicking in the white cell under Start Date and either 

enter/adjust details directly or utilise the dropdown calendar to select the 

Day/Month/Year. 

c. Select the Start or End Time by entering the Start Time or End Time HHMM that 

follows the Day/Month/Year. The first 00 represents hours and the last 00 

represents minutes in a 24-hour clock.  

d. If the shift extends past Midnight, Click the Work Over Midnight icon. 

e. Start and End Minutes can be easily adjusted by clicking a cell on the numeric 

pad. 

 

f. Shifts can be extended or shortened by using the left mouse button (held down) at 

start or end of the shift and dragging the blue bar, then release left mouse button 

to finish setting new time. 
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7.2. Sleep Schedule 

7.2.1. Sleep Schedule - reading an existing Sleep Schedule from a file 

 

 

Should the user have a Sleep Schedule file this can can be 

imported or loaded into FAID Quantum to allow additional data 

to be added to the Sleep Schedule or for further analysis.  

1. On the Inputs tab in the Input Table Editing select either 

Sleep Schedule 1 (or 2) from the drop-down View menu 

. 

2. Click on the Read Sleep Schedule from File  button 

to load a previously saved Sleep Schedule into FAID 

Quantum. 

3. In the Select File to Read dialogue box, the default file 

type will be FAID Sleep Schedule (*.fqs), clicking the drop-

down arrow will allow this file type to be changed to All 

Files to locate a database (e.g. a comma separated .csv 

file).  Locate and select the required File.  

4. Click the Open button.  

5. The selected Sleep Schedule file is loaded onto the Sleep 

Schedule screen.  

7.2.2. Creating a Sleep Schedule by copying Work Schedule to Sleep 

Schedule 

 

1. FAID Quantum offers the option to create a predicted 

Sleep Schedule by copying the Work Schedule to the 

Sleep Schedule. 

2. In the Input Table Editing section of the control panel, 

Select Sleep Schedule 1 (or 2) from the View drop-

down menu.  

3. Click the  button in the Input Table Editing menu, 

FAID Quantum will then create a predicted Sleep 

Schedule based on the existing Work Schedule, this 

can then be modified as required.  

Note:  If a Sleep Schedule is not supplied, when the Analysis 

is run, FAID Quantum will create the Sleep Schedule during 

the analysis process. 
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7.2.3. Adding a Sleep Schedule by copying data 

Users have the option to import a Sleep Schedule from a spreadsheet/database (e.g. Excel) 

into FAID Quantum onto the Sleep Schedule screen.    

 

1. In a spreadsheet (e.g. Excel), highlight the cells to be 

copied and right click to copy to the clipboard.   

 

2. On the Input tab Click on the Sleep Schedule  

button. 

3. In the Input Table Editing > View, select either Sleep 

Shecule 1 or 2. 

4. In Input Table Editing click on the Paste Clipboard to 

Sleep Schedule  button. An information box will 

display indicating the number of rows of data that were 

imported. Click the OK button to continue. 

 

 

5. The Sleep Schedule is imported onto the selected Sleep 

Schedule screen/Worksheet. 

 

NOTE: If there are rows of data currently in the Sleep 

Schedule an Information box will ask to Append to Current 

Sleep Schedule (Yes / No / Cancel).  

7.2.4. Adding Sleep Periods within FAID Quantum 

Users can create and add in Sleep Periods within FAID Quantum on either an existing Sleep 

Schedule or an empty Sleep Schedule, or, Sleep Schedules can be imported from a 

spreadsheet/database (e.g. Excel). Users have the option to create a Sleep pattern in either 

Single or Cycle mode. 

 

7.2.4.1. Adding a Single Sleep Period 

1. On the Input tab Click on the Sleep Schedule  

button. 

2. In Input Table Editing > View select Sleep Schedule 1 

(or 2) from the drop-down menu 

 

 
 



 

 FAID Quantum User Guide Page 56 of 137 

3. Enter the Name (either the name of the employee or a 

unique identifying code or number). If codes have been 

added, these will appear as a drop-down menu. 

4. Enter Start Time and End Time 

5. Enter Time till next Start in hours and minutes 

6. Click on the Add Single button. 

 

7.2.4.2. Adding a Cycle of Sleep Periods 

Follow steps 1 – 4 above 

5. Enter the number of consecutive Days On and Off for the 

cycle. 

6. Click on the Add Cycle button to add the entered work 

period details for the cycle onto the Work Schedule 

screen. Repeated clicking on the Add Cycle button will 

replicate the entered shift cycle details for successive 

date periods. 

 

7.3. External Result 

7.3.1. External Result Schedule - reading an existing External Result 

Schedule from a file 

 

 

Should the user have an External Result Schedule file this can 

be imported or loaded into FAID Quantum to allow additional 

data to be added to the External Result Schedule or for further 

analysis. There are many options for using the External Result 

feature; the result could be an incident, accident, near miss, 

self-assessment by individual at start or end of work period, 

behavioural alertness test results (ie PVT). 

1. On the Inputs tab in the Input Table Editing select either 

External Result Schedule 1 (or 2) from the drop-down 

View menu 

. 

2. Click on the Read External Result Schedule from File 

 button to load a previously saved External Result 

Schedule into FAID Quantum. 

3. In the Select File to Read dialogue box, the default file 

type will be FAID External Result Schedule (*.fqr), clicking 

the drop-down arrow will allow this file type to be changed 

to All Files to locate a database (e.g. a comma separated 

.csv file).  Locate and select the required File.  
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4. Click the Open button.  

5. The selected External Result Schedule file is loaded onto 

the External Result Schedule screen.  

  

7.3.2. Adding an External Result Schedule by copying data 

Users have the option to import an External Result Schedule from a spreadsheet/database (e.g. 

Excel) into FAID Quantum onto the External Result Schedule screen.    

 

1. In a spreadsheet (e.g. Excel), highlight the cells to be 

copied and right click to copy to the clipboard.   

2. On the Input tab Click on the External Result Schedule 

 button. 

3. In the Input Table Editing > View, select either External 

Result Schedule 1 or 2. 

4. In Input Table Editing click on the Paste Clipboard to 

External Result Schedule  button. An information 

box will display indicating the number of rows of data that 

were imported. Click the OK button to continue. 

 

 

5. The External Result Schedule is imported onto the 

selected External Result Schedule screen/Worksheet. 

 

NOTE: If there are rows of data currently in the External Result 

Schedule an Information box will ask to Append to Current 

External Result Schedule (Yes / No / Cancel).  

7.3.3. Adding External Result Periods within FAID Quantum 

Users can create and add in External Result Periods within FAID Quantum on either an existing 

External Result Schedule or an empty External Result Schedule, or External Result Schedules 

can be imported from a spreadsheet/database (e.g. Excel). Users have the option to enter 

external Result in either Single or Cycle mode. 



 

 FAID Quantum User Guide Page 58 of 137 

 

7.3.3.1. Adding a Single External Result 

1. On the Input tab Click on the External Result Schedule 

 button. 

2. In Input Table Editing > View select External Result 

Schedule 1 (or 2) from the drop-down menu 

 

 
 

3. Enter the Name (either the name of the employee or a 

unique identifying code or number). If codes have been 

added, these will appear as a drop-down menu. 

4. Enter Time 

5. Enter Time till next Start in hours and minutes 

6. Click on the Add Single button. 

 

7.3.3.2. Adding a Cycle of External Result 

Follow steps 1 – 4 above 

5. Enter the number of consecutive Days On and Off for 
the cycle. 

6. Click on the Add Cycle button to add the entered 
external Result details for the cycle onto the External 
Result Schedule screen. Repeated clicking on the Add 
Cycle button will replicate the entered shift cycle details 
for successive date periods. 
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7.4. Additional Input Table Editing Features 

7.4.1. Copying data out of FAID Quantum using the Clipboard 

 

Users have the option to export a Work Schedule from FAID 

Quantum to the clipboard and then paste into a 

spreadsheeet/database (e.g. Excel). 

 

1. On the Inputs tab in the Input Table Editing section, 

click the Copy Work Schedule to Clipboard   

button to copy the Work Schedule. 

 

2. Click Ok. 

 

3. Use the paste function to paste the Work Schedule into 

the spreadsheet. 

 

 

7.4.2. Sorting a Work, Sleep, or External Result Schedule by Name 

and Date 

 

When shifts or sleep periods are added after a Work , Sleep, 

or External Result Schedule has already been created, FAID 

Quantum always adds them as a new row at the bottom of 

the Schedule. 

 

To Sort by Name then Date, select either Work Schedule 

, Sleep Schedule , or External Result  and 

select either Schedule 1 or 2. 

In the Input Table Editing section click on the  button  

 

The Schedule will then be re-ordered by Name and then 

Date.  
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7.4.3. Deleting Work Periods within a Schedule 

 

Users can delete Work Periods (shifts), Sleep Periods, or 

External Results from a Schedule.   

To delete a work period or a sleep period, select either Work 

Schedule , Sleep Schedule , or External Result 

Schedule  and select the appropriate Schedule (1 or 2) from 

the Input Table Editing > View drop-down menu 

 

In the Input Table Editing section click on the Delete Row(s) 

from Schedule  button to activate the Edit Schedule 

Row(s) window. 

 

 

Edit Work Schedule Row(s) 

 

Edit Sleep Schedule Row(s) 

 

1. Enter the From Row number to delete from the Schedule. 

 

2. Enter the To Row number to delete from the Schedule. 

 

3. Click on the Delete button to delete the nominated work, 

sleep, or external results from the Schedule.   

 

NOTE: When deleting, be aware that the user will not be 

prompted to confirm deletion. It is recommended that the user 

regularly saves when changing data. 

 

NOTE:  Rows can be deleted from the Schedule when the user 

right mouse clicks on a row, and clicks on the word Delete.  
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7.4.4. Clearing an Entire Schedule 

 

Users can clear an entire Work, Sleep, or External Result 

Schedule of all entries. 

1. To Clear a specific entry, select either Work Schedule 

, Sleep Schedule , or External Result Schedule  

and select the appropriate Schedule (1 or 2) from the Input 

Table Editing > View drop-down menu. 

 

2. In the Input Table Editing section click on the Clear 

Schedule    button to clear all Work Periods (shifts) or 

Sleep periods, External Result within the displayed 

Schedule. 

 

3. A Delete Warning! will appear. Click on Ok to confirm the 

changes. 

 

 
Figure 7-1 Delete Warning for Work Schedule 

 

 
Figure 7-2 Delete Warning for Sleep Schedule 

 

 

7.4.5. Additional Work and External Result Schedule Editing Options 

Work and External Result Schedule editing is also available via a menu that is displayed when 

the user right mouse clicks on a row. Available options appear:  Append Row, Insert Row, 

Duplicate Row, Duplicate (Customised), Delete Row, Delete Error Row(s), Attempt Clean Error 

Row(s), Fill Down and Index Down. 

 

Figure 7-3 Work Schedule editing options using mouse 
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When selecting the Duplicate Row(s) 
Customised a pop-up display will appear 
where the user can select the From Row, To 
Row, a New Start Date, and the Name to 
use. 

 

7.4.6. Additional Sleep Schedule Editing Options 

Sleep Schedule editing is also available via a menu that is displayed when the user right mouse 

clicks on a row. The only available option is Delete Row. 

 

Figure 7-4 Sleep Schedule editing options using mouse 

 

 

 

7.4.7. Saving Work Schedules 

 

Users have the ability to save their Work Schedules and 

store the data for future reference.  

 

1. On the Inputs tab in the Input Table Editing section 

from the View drop drown menu, select the Work 

Schedule to be saved (Work Schedule 1 or 2). 

2. Click on the Save Work Schedule to File  button 

to save the currently displayed Work Schedule. 

3. In the Select File to Write dialogue box, enter or select 

a desired File Name. 

4. Choose the folder/file the user wants to save in. 

5. Click the Save button. 
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NOTE:  FAID Quantum file extension for Work Schedules is 

.fqw, which is effectively a comma separated text file (.csv) 

file format. 

 

NOTE:  Work Schedules 1 and 2 must be saved 

independently.  An easily recognised file naming convention 

which differentiates between Work Schedules 1 and 2 and 

notes their function, e.g. work_schedule_1_actual.fqw is 

recommended. 

 

7.4.8. Saving Sleep Schedules 

 

Users have the ability to save their Sleep Schedules and 

store the data for future reference.  

 

1. On the Inputs tab in the Input Table Editing section 

from the View drop drown menu, select the Sleep 

Schedule to be saved (Sleep Schedule 1 or 2). 

2. Click on the Save Sleep Schedule to File  button 

to save the currently displayed Sleep Schedule. 

3. In the Select File to Write dialogue box, enter or select 

a desired File Name. 

4. Choose the folder/file the user wants to save in. 

5. Click the Save button. 

 

NOTE:  The FAID Quantum Sleep Schedule file extension 

used is .fqs, which is effectively a comma separated text file 

(.csv) file format. 

 

NOTE:  Sleep Schedules 1 and 2 must be saved 

independently.  An easily recognised file naming convention 

which differentiates between Sleep Schedules 1 and 2 and 

notes their function, e.g. sleep_schedule_1_actual.fqs is 

recommended. 
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7.4.9. Saving External Result Schedules 

 

Users have the ability to save their External Result 

Schedules and store the data for future reference.  

 

1. On the Inputs tab in the Input Table Editing section 

from the View drop drown menu, select the External 

Result Schedule to be saved (Sleep Schedule 1 or 2). 

2. Click on the Save External Result Schedule to File 

 button to save the currently displayed External 

Result Schedule. 

3. In the Select File to Write dialogue box, enter or select 

a desired File Name. 

4. Choose the folder/file the user wants to save in. 

5. Click the Save button. 

 

NOTE:  The FAID Quantum External Result Schedule file 

extension used is .fqr, which is effectively a comma 

separated text file (.csv) file format. 

 

NOTE:  External Result Schedules 1 and 2 must be saved 

independently.  An easily recognised file naming convention 

which differentiates between External Result Schedules 1 

and 2 and notes their function, e.g. 

externalresult_schedule_1_actual.fqr is recommended. 
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7.4.10. Add In-Flight Rest 

 

This function allows the insertion of possible in-flight rest as 

well as nominating the quality of rest period as only Partial. 

This can be used when planning or assessing an actual 

roster to determine the impact of in flight sleep augmentation. 

In the Input Table Editing section click on the Add In Flight 

Rest  button in the Input Table Editing menu. 

Additional rows are added to the Work Schedule showing 

Post Shift Rest Quality as “Partial”, indicating an opportunity 

for in flight rest, taking into account the less than full quality 

sleep during inflight rest periods. 

NOTE:  Should the user wish to use this function and the 

appropriate icon is not visible (but the Sample icon is visible 

in bottom left hand corner), go to Admin > Settings > Aviation 

and change the In Flight Rest Button from No to Yes.   

TIP:  To be able to easily view the difference that adding In-

Flight Rest would make, first copy Work Schedule 1 to Work 

Schedule 2 and apply the In Flight Rest to Work Schedule 1, 

run the analysis and then compare Work Schedules. 

 

Please Note: “Partial” is defined as 50% of normal sleep quality and would normally apply to 

sleep achieved during in-flight rest. Such a selection would require Class 1 Quality Rest 

facilities to be available on the aircraft. 50% has only been populated for demonstration 

purposes. The percentage of sleep quality represented by the “Partial” setting needs to be 

determined by the operator and could then be adjusted within the software. It should be noted 

that good quality in-flight rest facilities are essential for “any” quality of sleep to be obtained. An 

appropriate sleep quality setting can be determined through a scientific sleep study and risk 

assessment process. 

 
Figure 7-5 Work Schedule after Flight Rest has been added 

NOTE: In the Input Settings Yes must be selected for Include Post Shift Rest Quality in order 

for In Flight Rest to be added. 
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8. INPUTS Tab - Analysis  

Once users have successfully added a Work Schedule (either 1 or 2), by their selected 

method, and have entered a Sleep Schedule if one is available (either 1 or 2), an analysis can 

be run to compare output results scored against the set Tolerance Levels. 

If a Sleep Schedule is not provided, FAID Quantum will generate a predicted Sleep Schedule 

during the analysis process. 

NOTE:  When analysing a work schedule with Time Zone movement, a work history of 15 days 

is recommended to best correct an individual’s current body clock before the start of the 

Analysis Period.   

 

 

 

 

1. Click on the Date and Period Wizard  button.  

This ensures analysis will pick up latest Work 

Schedule data and automatically sets the Start Date 

and History From Date fields ensuring the 

appropriate days of work history is used before Start 

Date. 

2. If the user is only interested in analysis of a subset of 

the data, in the Analysis Details options, enter the 

Start Date and the time Period to be analysed 

(remembering that seven days of work history should 

always be allowed before the desired Start Date which 

reflects the start of analysis outputs).  To analyse a 

subset of data, go to Admin > Settings > Analysis 

and ensure that Select Last Date for Analysis = Yes 

3. Click on the Analyse  button   

 

Also, the user can click on the Lock Date  button to lock the Analysis Details. 

 

 

The Lock Date  icon will appear to indicate the Analysis  
Details will not automatically change if Work Schedule is 
edited, unless the user manually edits a Date cell, or uses the 
Date and Period Wizard button. 

 

NOTE:  All data within either Work Schedule (1 or 2) or Sleep Schedules will be analysed. If 

data is entered into both Work Schedules 1 and 2 (and Sleep Schedules 1 and 2), they can be 

compared in the Outputs section.  
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If the Start Date is manually changed to the first date of shift data entered, the first week of 

analysis/Outputs will under-estimate the fatigue exposure of the hours of work, as no work 

periods existed in the preceding 15 days, when Time Zone movement in Work Schedule that 

have been counted as history data (when Input Settings > Work Schedule > Use Time Zone 

Details = Yes) or 7 days that have been counted as history data (when Input Settings > Work 

Schedule > Use Time Zone Details = No). Thus, it is recommended that the Start Date not be 

changed to the date of the first shifts entered. 

When reviewing time zone travel, fifteen days of history is required to ensure that a reasonable 

estimate is provided for the starting body clock of individuals.  

FAID Score: FAID Quantum uses the start and end times of the work periods (shifts) to analyse 

the fatigue exposure associated with the work hours in that work pattern. When a FAID Score 

Tolerance Level (FTL) is set, the analysis also calculates the time an individual spends at 

various FAID Condition levels.  

KSS:  The FAID Quantum BMM is able to determine a KSS score from predicted sleep periods 

utilising an implementation of the Three Process Model of Alertness (Akerstedt & Folkard,1995). 

The implementation in FAID Quantum BMM does not include the sleep inertia component of 

that model.  Resulting outputs can be viewed and examined by using the various functions 

available on the Outputs tab. 
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9. OUTPUTS Tab 

  

Once a Work Schedule is analysed, the user will be 

presented with the Hours at Result - KSS Summary screen 

as a default view.   

  

This Summary can be re-accessed by clicking on the 

Summary   button. 

 

The Outputs tab is split into four sections: 

 

• Summary 

• Schedule 

• Individual Score 

• Utilisation 

9.1. Summary 

9.1.1. Hours at Result – KSS Summary 

If a KTL was selected, on this screen FAID Quantum provides the Compliance percentage 

which is the percentage of hours of the analysed Sleep Schedule that are below the set 

Tolerance Level, as well as the user defined corporate Target Compliance percentage to 

compare performance against (if Target Compliance percentage is not displayed, go to Inputs > 

Admin > Settings > Summary > Display Target Compliance % = No and change to Yes (see 

Section 6.1.3.1).   

The screen also displays the KSS Conditions for the total number of hours worked within the 

analysed Work Schedule. These can be used to categorise the level of controls that are 

required to be implemented by users based on the scale that is set by FAID Quantum. KSS 

Conditions use the following scale: 

• Red  (KSS points above the KTL) 

• Yellow  (Within 1 KSS point of the KTL) 

• Green (Less than 1 KSS point below the KTL) 

If two Work Schedules have been added, all Display Options will show both Work Schedules for 

comparison purposes. 
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The Hours at Result - KSS display gives a summary of 

the overall analysis of the Work Schedule. In-depth 

explanations of the results follow. 

  

 

  

 

This graph displays the % of Time in KSS Conditions 

(Green, Yellow & Red) over the entire Work Schedule. 

When the Display Option Shift Peak Condition GYR 

is selected, the graph shows number and percentage 

of shifts in KSS Conditions. 

  

 

Compliance % for the Sleep Schedule as a whole is 

displayed, as well as the user defined corporate Target 

Compliance %. Depending on the Display Option 

chosen, this changes from Compliance Hours to 

Compliance Shifts. 

  

 

This table shows total hours worked based on KSS 

Conditions when Display option for hours is selected. 

When the Display Option for shifts (i.e. Shift Peak 

GYR Condition) is selected, the table shows number 

and percentage of shifts in KSS Conditions rather 

than hours in KSS Conditions. 
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9.1.2. Hours at Result – FAID Score Summary 

If  a Tolerance Level was selected, on this screen FAID Quantum provides the Compliance 

percentage which is the percentage of hours of the analysed Work Schedule that are below the 

set Tolerance Level, as well as the user defined corporate Target Compliance percentage to 

compare performance against (if Target Compliance percentage is not displayed, goto Inputs > 

Admin > Settings > Outputs > Summary > Display Target Compliance % = No and change to 

Yes (see Section 6.1.3.1).   

The screen also displays the FAID Conditions for the total number of hours worked within the 

analysed Work Schedule. These can be used to categorise the level of controls that are 

required to be implemented by users based on the scale that is set by FAID Quantum. FAID 

Conditions use the following scale: 

• Red  (Above FTL) 

• Yellow  (Within 10 points of FTL) 

• Green (Less than 10 points below FTL) 

If two Work Schedules have been added, all Display Options will show both Work Schedules for 

comparison purposes. 

 

The Hours at Result FAID Score display gives a summary 

of the overall analysis of the Work Schedule. In-depth 

explanations of the results follow. 

   

  

 

This graph displays the % of Time in FAID Conditions 

(Green, Yellow & Red) over the entire Work Schedule. 

When the Display Option Shift Peak Condition GYR is 

selected, the graph shows number and percentage of 

shifts in FAID Conditions. 
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Compliance % for the Work Schedule as a whole is 

displayed, as well as the user defined corporate Target 

Compliance %. Depending on the Display Option chosen, 

this changes from Compliance Hours to Compliance 

Shifts. 

  

 

This table shows total hours worked based on FAID 

Conditions when Display option for hours is selected. 

When the Display Option for shifts (i.e. Shift Peak GYR 

Condition) is selected, the table shows number and 

percentage of shifts in FAID Conditions rather than 

hours in FAID Conditions. 

 

The default Display Option is Hours at Result. 

 

In Display Options, click in the Display box, a drop-

down menu provides the options. 

 

9.1.3. Apparent Tolerance – KSS Summary 

The Apparent KTL display represents the compliance of each 

individual and an overall Sleep Schedule compliance for different 

KTLs ranging from one to highest needed to achieve 100% 

compliance, with a highlighted display of the KTL when overall 

98% (default) compliance is achieved. The ‘Apparent’ Tolerance Level represents the KSS at 

which (by default) 98% of the hours analysed are less than (or within). Hence, a higher 

‘Apparent’ KTL indicates higher fatigue exposure for the hours analysed. The actual percentage 

can be specified in the Settings section. This view is similar to that seen when No KTL is 

chosen in Inputs. When six to twelve months of Actual Hours of Work are analysed, the 

Apparent KTL indicates 

the level of hours of work-

related fatigue risk that the 

organisation has been 

tolerating 98% of the time 

(in this example). It also 

defines a point from which 

to begin investigating 

business processes that 

resulted in the outlying 2% 

of hours and informing 

decisions around the 

setting of KTLs.  
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9.1.4. Apparent Tolerance – FAID Score Summary 

The Apparent FTL (default with No FTL) display represents the 

compliance of each individual and an overall Work Schedule 

compliance for different FTLs ranging from zero to highest needed 

to achieve 100% compliance, with a highlighted display of the FTL 

when overall 98% (default) compliance is achieved. The ‘Apparent’ Fatigue Score Tolerance 

Level represents the FAID Score at which (by default) 98% of the hours analysed are less than 

(or within). Hence, a higher ‘Apparent’ FTL indicates higher fatigue exposure for the hours 

analysed. The actual percentage can be specified in the Settings section. This view is similar to 

that seen when No FTL is chosen in Inputs. When six to twelve months of Actual Hours of Work 

are analysed, the 

Apparent FTL indicates 

the level of hours of work-

related fatigue risk that the 

organisation has been 

tolerating 98% of the time 

(in this example). It also 

defines a point from which 

to begin investigating 

business processes that 

resulted in the outlying 2% 

of hours and informing 

decisions around the 

setting of FTLs. 

9.1.5. Cumulative Profile – KSS Summary 

 

The Cumulative Profile display shows the cumulative percentage 

of total hours at each 1 KSS bracket. A profile showing a quick 

rise in the y-axis would represent the bulk of the total hours being 

worked at a lower KSS, with a lesser percentage of the hours 

worked at the higher end of the scale. 
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9.1.6. Cumulative Profile – FAID Score Summary 

 

The Cumulative Profile display shows the cumulative percentage 

of total hours at each FAID Score, from lowest to highest. A 

profile showing a quick rise in the y-axis would represent the bulk 

of the total hours being worked at lower FAID Scores, with a 

lesser percentage of the hours worked at the higher end of the 

scale. 

 

 

9.1.7. Dashboard – KSS Summary 

If a KTL was selected, on this screen FAID Quantum provides the Compliance percentage 

which is the percentage of hours, and shifts, of the analysed Work Schedule that are below the 

set Tolerance Level, as well as the user defined corporate Target Compliance percentage to 

compare performance against (if Target Compliance percentage is not displayed, go to Inputs > 

Admin > Settings > Summary > Display Target Compliance % = No and change to Yes (see 

Section 6.1.3.1).   

The screen also displays the Peak KSS Score and Apparent Tolerance Level for the total 

number of hours worked within the analysed Work Schedule. These can be used to categorise 

the level of controls that are required to be implemented by users based on the scale that is set 

by FAID Quantum. KSS Conditions use the following scale: 

• Red  (KSS points above the KTL) 

• Yellow  (Within 1 KSS point of the KTL) 

• Green (Less than 1 KSS point below the KTL) 

If two Work Schedules have been added, all Display Options will show both Work Schedules for 

comparison purposes. 
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There are Display Options for the Dashboard view. 

Results can be KSS, FAID Score, or a combination of 

both. 

The View has the options, via tick box, to have: 

• Hours Worked 

• Shifts Worked 

• Peak Score 

• Apparent TL 

  

 

  

 

 

The donut graphs displays the selected View (Hours, 

Shifts, Peak Score) over the entire Work Schedule. 

The graph shows number and percentage of hours, or 

shifts, in KSS Conditions. 

 

The corporate Target Compliance % is indicated. 

Depending on the Display Option chosen, this 

changes from Compliance Hours to Compliance 

Shifts. 

 

 

 

Red dot for non-compliance, Green dot for 

compliance. If Two-Levels selected in Settings – 

Ouputs then Yellow dot will be displayed too.  

9.1.8. Dashboard – FAID Score Summary 

If  a Tolerance Level was selected, on this screen FAID Quantum provides the Compliance 

percentage which is the percentage of hours, and shfits, of the analysed Work Schedule that 

are below the set Tolerance Level, as well as the user defined corporate Target Compliance 

percentage to compare performance against (if Target Compliance percentage is not displayed, 

goto Inputs > Admin > Settings > Outputs > Summary > Display Target Compliance % = No and 

change to Yes (see Section 6.1.3.1).   

The screen also displays the Peak FAID Score and Apparent Tolerance Level for the total 

number of hours worked within the analysed Work Schedule. These can be used to categorise 
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the level of controls that are required to be implemented by users based on the scale that is set 

by FAID Quantum. FAID Conditions use the following scale: 

• Red  (Above FTL) 

• Yellow  (Within 10 points of FTL) 

• Green (Less than 10 points below FTL) 

If two Work Schedules have been added, all Display Options will show both Work Schedules for 

comparison purposes. 

 

There are Display Options for the Dashboard view. 

Results can be FAID Score, KSS, or a combination of 

both. 

The View has the options, via tick box, to have: 

• Hours Worked 

• Shifts Worked 

• Peak Score 

• Apparent TL 

  

 

  

 

 

The donut graphs displays the selected View (Hours, 

Shifts, Peak Score) over the entire Work Schedule. 

The graph shows number and percentage of hours, or 

shifts, in FAID Conditions. 

 

The corporate Target Compliance % is indicated. 

Depending on the Display Option chosen, this 

changes from Compliance Hours to Compliance 

Shifts. 

 Red dot for non-compliance, Green dot for 

compliance. If Two-Levels selected in Settings – 

Ouputs then Yellow dot will be displayed too.  
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9.1.9. Risk Profile – KSS Summary 

 

The Risk Profile display shows a count of how many individuals 

peaked in Green, Yellow or Red KSS Conditions, and places 

them into the matrix based on their relevant Compliance % band 

(as set-up in the Settings section of the Inputs tab) and Peak KSS 

Condition. Also displayed are the Total Hours worked and the 

percentage of KSS Condition Hours. In the example below, the 

work patterns analysed showed 20 individuals with scores 

peaking in the KSS Red Condition (above the KTL) with 

Compliance percentages <90% and one individual Compliance 

between 95 and 98%. 

 

9.1.10. Risk Profile – FAID Score Summary 

 

The Risk Profile display shows a count of how many individuals 

peaked in Green, Yellow or Red FAID Conditions, and places 

them into the matrix based on their relevant Compliance % band 

(as set-up in the Settings section of the Inputs tab) and Peak FAID 

Condition. Also displayed are the Total Hours worked and the 

percentage of FAID Condition Hours. In the example below, the 

work patterns analysed showed 13 individuals with FAID Scores 

peaking in the FAID Red Condition (above the FTL) with 

Compliance percentages lower than 98%.  Four individuals’ peak 

scores were within 10 points of the FTL, and the remaing four 

individuals had Peak FAID Scores less than 10 points below the 

FTL. 
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9.1.11. Shift Peak Condition GYR – KSS Summary 

 

The Shift Peak Condition GYR display indicates how 

many shifts achieved the various KSS Conditions (in 

Green, Yellow, Red). Also displayed are the Total Shifts 

worked and the percentage of Shifts Peaks for the 

different KSS Conditions. 

 

 

9.1.12. Shift Peak Condition GYR – FAID Score Summary 

 

The Shift Peak Condition GYR display indicates how 

many shifts achieved the various FAID Score 

Conditions (in Green, Yellow, Red). Also displayed are 

the Total Shifts worked and the percentage of Shifts 

Peaks for the different FAID Score Conditions. 
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9.2. Key Risk Indicators 

There are different types of Key Risk Indicators available on the Output tab in the Summary 

section, which can be used to analyse a Work Schedule, each Key Risk Indicator is broken 

down into KSS and FAID Score outputs.   

The Key Risk Indicators are: 

• Compliance - Percentage to the KSS (or FAID Score) Tolerance Level for hours worked 

• Peak Condition – Peak KSS (or FAID Score) Condition for Work Periods 

• Hour of Day - Hours worked profile & Percentage of Hours Worked above the set 

Tolerance Level. 

• Monthly Compliance - Graphical display of the Compliance each month 

• Rollup Peak Condition – Peak KSS (or FAID Score) Condition for Rolled up Work 

Periods (if in Settings Outputs Perform Rollup in Outputs = Yes).  

• External Results – KSS (or FAID Score) for external results at the time, or within one 

hour of work period (if in Settings Inputs Inport External Results = Yes).  

 

9.2.1. Compliance – KSS 

  

 

 

1.  On the Outputs tab in the Summary section click on the 

Key Risk Indicators   button. 

 

2. In the Display Options section, the default in Display is 

Compliance, and in the Result select KSS which details 

the KTL Compliance Percentage overall and per Name, as 

well as the percentage of time in each KSS Condition. 

 

3. The Compliance Work Schedule table can be sorted by:  

• Name 

• Total Hours 

• Total Hours >KTL 

• Compliance (%) 

• KSS Condition Green % 

• KSS Condition Yellow % 

• KSS Condition Red %  

• Peak KSS 

• Apparent KTL * 

 

 *optional if Selected in Settings – Outputs. 
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Figure 9-1 Key Risk Indicators - KTL Compliance % Report 

 

9.2.2. Compliance – FAID Score 

  

 

 

1. On the Outputs tab in the Summary section click on the 

Key Risk Indicators   button. 

 

2. In the Display Options section, the default in Display is 

Compliance, and in the Result select FAID Score which 

details the FTL Compliance Percentage overall and per 

Name, as well as the percentage of time in each FAID 

Score Condition. 

 

3. The Compliance Work Schedule table can be sorted by:  

• Name 

• Total Hours 

• Total Hours >FTL 

• Compliance (%) 

• FAID Condition Green % 

• FAID Condition Yellow % 

• FAID Condition Red %  

• Peak FAID Score 

• Apparent FTL * 

 

 * Optional if selected in Settings – Outputs 
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Figure 9-2 Key Risk Indicators - FTL Compliance % Report 

 

As part of the Key Risk Indicators, the Compliance % table indicates the Total Hours worked 

over the whole Work Schedule, the Total Hours worked above the KSS, and FAID Score, 

Tolerance Level, the Compliance as a percentage and the percentage of time spent in the 

different FAID Conditions.  

This is further expanded in the bottom table, where the figures are broken down by individual 

statistics.  

TIP:  In order to facilitate quicker and easier access to the data, direct navigation is possible to 

a chosen individual’s FAID Score Plot or Table from any table of summary or Work Schedule in 

the Output sections via a simple right-click selection.

 

Figure 9-3 Right clicking on a row to retrieve additional data 
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9.2.3. Peak Condition for Work Periods – KSS 

 

1. On the Outputs tab, in the Summary section click on 

the Key Risk Indicators   button. 

2. In the Key Indicators Display Options section, from the 

drop-down menus, select Peak Condition for Display 

and select KSS for Result. 

3. The Work Schedule table can be sorted in ascending 

or descending order by: 

• Name  

• #Green 

• #Yellow 

• #Red 

• Total 

• %Green  

• %Yellow  

• %Red 

 

The Peak KSS Conditions for Work Periods tables provide a breakdown of the Work Periods 

based on the Peak KSS Conditions achieved.  

The top table shows the total number of work periods in the Work Schedule, how many work 

periods and the percentage of work periods categorised into each Peak KSS Condition. 

The lower table shows the number and percentages of work periods for each individual and 

how they are categorised into each Peak KSS Condition. 

NOTE:  FAID Quantum nominally categorises KSS Conditions using the following scale: 

• Red  (KSS points above the KTL) 

• Yellow  (Within 1 KSS point of the KTL) 

• Green (Less than 1 KSS point below the KTL) 

 



 

 FAID Quantum User Guide Page 82 of 137 

9.2.4. Peak Condition for Work Periods – FAID Score 

 

1. On the Outputs tab, in the Summary section click on 

the Key Risk Indicators   button. 

2. In the Key Indicators Display Options section, from the 

drop-down menus, select Peak Condition for Display 

and select FAID Score for Result. 

3. The Work Schedule table can be sorted in ascending 

or descending order by: 

• Name  

• #Green 

• #Yellow 

• #Red 

• Total 

• %Green  

• %Yellow  

• %Red 

 

The Peak FAID Score Conditions for Work Periods tables provide a breakdown of the Work 

Periods based on the Peak FAID Score Conditions achieved.  

The top table shows the total number of work periods in the Work Schedule, how many work 

periods and the percentage of work periods categorised into each Peak FAID Score Condition. 

The lower table shows the number and percentages of work periods for each individual and 

how they are categorised into each Peak FAID Score Condition. 

NOTE:  FAID Quantum nominally categorises FAID Score Conditions using the following scale: 

• Red  (Above FTL) 

• Yellow  (Within 10 points of FTL) 

• Green (Less than 10 points below FTL) 
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9.2.5. Hour of Day Profile – KSS 

 

1. On the Outputs tab in the Summary section click on 

the Key Risk Indicators    button. 

 

2. From the drop-down menus in the Display Options 

select Hour of Day in Display and KSS in Result. 

 

3. The Hours Worked Profile table and Percentage (%) 

of hours Worked > Tolerance Level table can display: 

 

• Days of Week 

• Weekly  

• Monthly 

 

 

Figure 9-4 - Days of Week showing Local time 
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Figure 9-5 Days of Week showing UTC time 

The Hours of Day Worked Profile screen shows the Hours Worked Profile table and the 

Percentage (%) of Hours Worked > Tolerance Level table. On this screen the user can 

examine the relative fatigue exposure at each hour of the day. 

The Hours Worked Profile table shows the total number of hours worked at specific times of 

the day for the entire Work Schedule, using either UTC or Local Time (if Time Zones used 

during the Analysis process). 

The Percentage of Hours Worked > Tolerance Level table shows the percentage of hours 

worked at specific times of the day which exceed the set KTL. 
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9.2.6. Hour of Day Profile – FAID Score 

 

1. On the Outputs tab in the Summary section click on 

the Key Risk Indicators    button. 

 

2. From the drop-down menus in the Display Options 

select Hour of Day in Display and FAID Score in 

Result. 

 

3. The Hours Worked Profile table and Percentage (%) 

of hours Worked > Tolerance Level table can display: 

 

• Days of Week 

• Weekly  

• Monthly 

 

 

  
Figure 9-6 - Days of Week showing Local time 
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Figure 9-7 Days of Week showing UTC time 

The Hours of Day Worked Profile screen shows the Hours Worked Profile table and the 

Percentage (%) of Hours Worked > Tolerance Level table. On this screen the user can 

examine the relative fatigue exposure at each hour of the day. 

The Hours Worked Profile table shows the total number of hours worked at specific times of 

the day for the entire Work Schedule, using either UTC or Local Time (if Time Zones used 

during the Analysis process). 

The Percentage of Hours Worked > Tolerance Level table shows the percentage of hours 

worked at specific times of the day which exceed the set FTL. 

NOTE: 

• In the Hours Worked Profile table - the greater the number of hours worked the 

deeper the colour blue.  

• In the Percentage of Hours Worked > Tolerance Level table – the greater the 

percentage of hours above the FTL the deeper the colour purple.  

• The cells in both tables correspond to the same period of time. 

• In the KRI’s Hours Worked Profile section the number displayed for Hours Worked 

Profile can be switched off if there are large numbers in the analysis that are affecting 

the view. Clicking in the cell Show # toggles between Yes (display numbers) and No 

(don’t display numbers). 
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9.2.7. Monthly Compliance Graph 

 

1. On the Outputs tab in the Summary section click on the 

Key Risk Indicators    button. 

 

2. From the in the Display Options drop-down menu select 

Monthly Compliance and then select either KSS or 

FAID Score from the Result drop-down menu. 

 

 

  

Figure 9-8 KSS Monthly Compliance Graph – Target Compliance set at 90% 

   

Figure 9-9 FAID Score Monthly Compliance graph – Target Compliance set at 90% 
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The Monthly Compliance Graph is a graphical output reporting the overall Compliance % 

based on the period of the Work Schedule analysed for each month of the year.  

It is useful as an auditing tool once a substantial portion of roster data is available (e.g. 1 year).  

In Inputs under Tolerance Level – Tolerance Thresholds, the user can set the Target 

Compliance percentage for the Work Schedule for both KSS and FAID Score. The Monthly 

Compliance Graph tracks compliance against the target compliance over a twlelve month 

period. On the graphs, above the set Target Compliance level (set at 90%) is coloured blue, 

below is white. If the graph line dips below the blue into the white in a given month, the Work 

Schedule for that month is non-compliant. By default, the Target Compliance is set to 98%.  

9.2.8. Rollup Peak Condition - KSS 

To obtain outputs for Rollup Peak Condition, in Input > Settings > Outputs, Perform Rollup 

should = Yes. 

 

 

1. On the Outputs tab, in the Summary section click on 

the Key Risk Indicators    button. 

2. In the Key Indicators Display Options section, from the 

drop-down menus, select Rollup Peak Condition for 

Display, then choose Result = KSS. 

3. The Rolled up Work Periods table can be sorted in 

ascending or descending order by: 

• Name  

• Number Maximum Rolled up Green 

• Number Maximum Rolled up Yellow 

• Number Maximum Rolled up Red 

• Total 

• Percentage Maximum Rolled up Green  

• Percentage Maximum Rolled up Yellow  

• Percentage Maximum Rolled up Red 
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Figure 9-10 Peak FAID Conditions for Rolled Up Work Periods - Result = KSS 

The Peak KSS Conditions for Rolled up Work Periods tables provide a breakdown of the Rolled 

up Work Periods based on the Peak KSS Conditions achieved.  

The top table shows the total number of rolled up work periods in the Work Schedule, how 

many rolled up work periods and the percentage of rolled up work periods categorised into each 

Peak KSS Condition. 

The lower table shows the number and percentages of rolled up work periods for each 

individual and how they are categorised into each Peak KSS Condition. 

NOTE:  FAID Quantum nominally categorises KSS Conditions using the following scale: 

• Red  (Above KTL) 

• Yellow  (Within 1 point of KTL) 

• Green (Less than 1 point below KTL) 
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9.2.9. Rollup Peak Condition – FAID Score 

To obtain outputs for Rollup Peak Condition, in Input > Settings > Outputs, Perform Rollup 

should = Yes. 

 

 

1. On the Outputs tab, in the Summary section click on the 

Key Risk Indicators   button. 

2. In the Key Indicators Display Options section, from the 

drop-down menus, select Rollup Peak Condition for 

Display, then choose Result = FAID Score). 

3. The Rolled up Work Periods table can be sorted in 

ascending or descending order by: 

• Name  

• Number Maximum Rolled up Green 

• Number Maximum Rolled up Yellow 

• Number Maximum Rolled up Red 

• Total 

• Percentage Maximum Rolled up Green  

• Percentage Maximum Rolled up Yellow  

• Percentage Maximum Rolled up Red 

 

 

Figure 9-11 Peak FAID Conditions for Rolled Up Work Periods - Result = FAID Score 

The Peak FAID Score Conditions for Rolled up Work Periods tables provide a breakdown of the 

Rolled up Work Periods based on the Peak FAID Score Conditions achieved.  
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The top table shows the total number of rolled up work periods in the Work Schedule, how 

many rolled up work periods and the percentage of rolled up work periods categorised into each 

Peak FAID Score Condition. 

The lower table shows the number and percentages of rolled up work periods for each 

individual and how they are categorised into each Peak FAID Score Condition. 

NOTE:  FAID Quantum nominally categorises FAID Score Conditions using the following scale: 

• Red  (Above FTL) 

• Yellow  (Within 10 points of FTL) 

• Green (Less than 10 points below FTL) 

 

9.2.10. External Results – KSS 

 

1. On the Outputs tab, in the Summary section click on the 

Key Risk Indicators  button. 

2. In the Key Indicators Display Options section, from the 

drop-down menus, select External Results for Display 

and select KSS for Result. 

 

The External Results by Result Block tables provide a breakdown of the KSS achieved at the 

time of the external result. The KSS is grouped into blocks starting at ‘1 to 2’ up to ‘8 to 9’. 
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9.2.11. External Results – FAID Score 

 

1. On the Outputs tab, in the Summary section click on the 

Key Risk Indicators  button. 

2. In the Key Indicators Display Options section, from the 

drop-down menus, select External Results for Display 

and select FAID Score for Result. 

 

The External Results by Result Block tables provide a breakdown of the FAID Score achieved 

when the External Results occur.  The FAID Score is grouped into blocks of ten starting at ‘0 to 

10’ up to the highest FAID Score achieved. 
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9.2.12. Combination Result Displays – FAID Score and KSS 

 

1. On the Outputs tab, in the Summary section click on the 

Key Risk Indicators  button. 

2. In the Key Indicators Display Options section, from the 

drop-down menus, select Compliance or Peak 

Condition for Display. 

3. Select FS and KSS for Result from the drop-down 

menu. 

4. Both FAID Score and KSS Results will be displayed 

together on the one table. 

 

 

9.3. Exposure Logs / Work Periods in Red Conditions 

 

 

 

The Tolerance Level Exposure Logs screen displays a table 

output for reporting individual work period details for 

individual(s) that have exceeded the KTL or FTL during a 

specific work period. There are two exposure log reports 

available for use:  

• Exposure Only 

• Exposure and History Log 

 

1. On the Outputs tab in the Summary section click on the 

Tolerance Level Exposure Logs    button. 

 

2. In Display Options from the View drop-down menu 

select the appropriate Work Schedule (1 or 2), and from 

the Result drop-down menu select either KSS or FAID 

Score then from Shifts select to view Exposure Only or 

Exposure and History viewing on the Report. 
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Extra Columns can be displayed as follows: 

KSS 

• KSS Condition Yellow 

• KSS Condition Red 

• Peak KSS 

• Peak KSS Condition  

Other  

• Exposure Controls 

• Task Risk 

• Non-Work 

• Work

FAID  

• FAID Condition Yellow 

• FAID Condition Red 

• Peak FAID Score 

• Peak FAID Condition 

Aviation 

• Location Codes 

• Location Times 

• Location Time Zones 

Sleep 

• Post Shift Rest Quality 

• Sleep Est Prior 24 hours 

• Sleep Est Prior 48 Hours 

Schedule 

• Show Sleep Schedule
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9.3.1. Exposure and History Log - KSS 

The Exposure and History Log displays only the shifts/work periods that have exceeded the 

KTL, as well as the details of the shifts in the proceeding 168 hours. This allows the user to 

investigate the shift pattern that caused the higher KSS exposure, and make potential changes 

to an individual’s work periods to avoid exposure to the Red KSS Condition (if planned shifts). 

Users are also able to record reasons for higher exposure and any controls implemented 

against the relevant work period.  

To record Controls or other commentary, the User clicks in the Describe Controls Applied cell 

in the applicable row. Yes appears in the cell and the user can enter the control applied in the 

‘Describe Controls Applied’ cell. To remove the commentary, delete the Control 

description/commentary entered and click on Yes and the cell reverts to a blank cell (no 

controls applied). 

  
Figure 9-12 Exposure & History Log Table showing controls applied 

 

9.3.2. Exposure Only Log – KSS 

The Exposure Only log displays only the shifts/work periods that have exceeded the KTL. It 

displays the amount of time for the work period an individual will spend in the Yellow and Red 

KSS Conditions. It also allows the user to record and describe, against the work period, any 

Controls put in place to mitigate any risks involved, or what operational circumstances resulted 

in the exceeding of the KTL.  

To record Controls or other commentary, the user clicks in the Describe Controls Applied cell 

in the applicable row. Yes appears in the cell and the user can enter the control applied in the 

‘Describe Controls Applied’ cell. To remove the commentary, delete Control 

description/commentary entered and click on Yes and the cell reverts to a blank cell (no 

controls applied).  

 
Figure 9-13 Exposure Only Log Table showing controls applied 
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9.3.3. Exposure and History Log – FAID Score 

The Exposure and History Log displays only the shifts/work periods that have exceeded the 

FTL, as well as the details of the shifts in the proceeding 168 hours. This allows the user to 

investigate the shift pattern that caused the higher fatigue exposure, and make potential 

changes to an individual’s work periods to avoid exposure to the Red FAID Condition (if 

planned shifts). Users are also able to record reasons for higher exposure and any controls 

implemented against the relevant work period.  

To record Controls or other commentary, the User clicks in the Describe Controls Applied cell 

in the applicable row. Yes appears in the cell and the user can enter the control applied in the 

‘Describe Controls Applied’ cell. To remove the commentary, delete the Control 

description/commentary entered and click on Yes and the cell reverts to a blank cell (no 

controls applied).  

 

 
Figure 9-14 Exposure & History Log Table showing controls applied 

 

9.3.4. Exposure Only Log – FAID Score 

The Exposure Only log displays only the shifts/work periods that have exceeded the FTL. It 

displays the amount of time for the work period an individual will spend in the Yellow and Red 

FAID Conditions. It also allows the user to record and describe, against the work period, any 

Controls put in place to mitigate any risks involved, or what operational circumstances resulted 

in the exceeding of the FTL.  

To record Controls or other commentary, the user clicks in the Describe Controls Applied cell 

in the applicable row. Yes then appears in the cell and the user can enter the control applied in 

the ‘Describe Controls Applied’ cell. To remove the commentary, delete Control 

description/commentary entered and click on Yes and the cell reverts to a blank cell (no 

controls applied).  

 
Figure 9-15 Exposure Only Log Table 
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9.4. Work & Sleep Schedules 

Work and Sleep Schedules are a visual display of the Work Schedules with the KSS and FAID 

Conditions against each individual shift and how many hours and minutes were spent in each 

Condition. 

9.4.1. Work Schedule Output 

 

 
Figure 9-16 Work Schedule Output with Extra Columns = FAID and all boxes checked no other Extra Columns checked 

 

Extra Column Options (depending on what Settings have been selected):   

 

 

1. On the Outputs tab in the Schedule section click on the 

Work Schedule    button. 

2. In the Display Options section, click on the View drop-

down menu and select Work Schedule 1. When a 

second Work Schedule has been added for a 

comparison of actual to planned Work Schedules (for 

example), select Work Schedule 2 from the drop-down 

menu.  

3. The default Sort By display is sort by Name / 

Ascending. Other sorting options are: 

• FAID Condition Yellow 

• FAID Condition Red 

• Peak FAID Score 

• KSS Condition Yellow 

• KSS Condition Red 

• Peak KSS 

 

4. Extra Details provide the opportunity to display KSS, 

FAID Score, Sleep, Aviation, Other, and Schedule 

outputs when viewing the Work Schedule simply by 

checking the boxes against each option.  When extra 

columns are added, the Sort By drop-down menu 

expands to include those extra columns checked.  
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KSS 

• KSS Condition Green 

• KSS Condition Yellow 

• KSS Condition Red 

• Peak KSS 

• Peak KSS Condition  

Other  

• Location Codes 

• Activity Code 

• Task Risk 

• Non-Work 

• Work

FAID  

• FAID Condition Green 

• FAID Condition Yellow 

• FAID Condition Red 

• Peak FAID Score 

• Peak FAID Condition 

Time Zone 

• Location Times 

• Location Time Zones 

Sleep 

• Sleep 

• Post Shift Rest Quality 

• Sleep Est Prior 24 hours 

• Sleep Est Prior 48 Hours 

• Sleep Type 

Schedule 

• Show Sleep Schedule 

• Show Work Schedule 

TIP:  Clicking on the Copy Work Schedule Output to Clipboard  button allows the data 

to be used in reports. 

TIP:  A plus sign in the column on the far left of the Work Schedule Output indicates a shift 

which has been “rolled-up”. Right clicking on a row provides the option to Open all Activities (-) 

or Close all Activities (+). Opening all Activities expands the ‘rolled-up’ shifts, for more 

information on Multiple Shifts Roll-up and how they are determined, see Section 6.1.3.5. 

 
Figure 9-17 Work Schedule 1 sorted by Name 

 
Figure 9-18 The same Work Schedule as in Figure above with Rolled-up Shifts expanded (Rows 4 - 9) 

NOTE:  At the bottom of each Work Schedule output, a scroll bar allows the user to scroll 

across and view Extra Columns. 

 
Figure 9-19 Scroll bar 
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9.4.2. Sleep Schedule Output 

 

  

 

 

 

 

 

 

1. When External Results are included in the analysis; on 

the Outputs tab in the Schedule section click on the 

Work Schedule    button  

2. From the Extra Columns select Schedule and from the 

drop-down menu check show Sleep Schedule. 

3. In the Display Options section, click on the View drop-

down menu and select Sleep Schedule 1. When a 

second Sleep Schedule has been added for a 

comparison of actual to planned Work Schedules (for 

example), select Sleep Schedule 2 from the drop-down 

menu. 

4. When no External Results are included in the analysis; 

on the Outputs tab in the Schedule section click on the 

Sleep Schedule    button. 

5. The default Sort By display is sort by Name / 

Ascending. Other sorting options are 

• UTC Start 

• UTC End 

• Sleep DN 

• KSS Condition Green 

• KSS Condition Yellow 

• KSS Condition Red 

• Peak FAID Score 

• Peak FAID Condition 

6. Extra Details provide the opportunity to display FAID, 

Sleep, Aviation, Other and Schedule outputs when 

viewing the Sleep Schedule simply by checking the 

boxes against each option.  When extra columns are 

added, the Sort By drop-down menu expands to include 

those extra columns checked.  
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Extra Column Options (depending on what Settings have been selected):  

KSS 

• KSS Condition Green 

• KSS Condition Yellow 

• KSS Condition Red 

• Peak KSS 

• Peak KSS Condition  

 

Other  

• Location Codes 

• Activity Code 

• Task Risk 

• Non-Work 

• Work

 

• FAID  

• FAID Condition Green 

• FAID Condition Yellow 

• FAID Condition Red 

• Peak FAID Score 

• Peak FAID Condition 

Aviation 

• Location Times 

• Location Time Zones 

Sleep 

• Sleep 

• Post Shift Rest Quality 

• Sleep Est Prior 24 hours 

• Sleep Est Prior 48 Hours 

• Sleep Type 

Schedule 

• Show Work Schedule 

• Show Sleep Schedule 

 
Figure 9-20 Sleep Schedule Output with Extra Columns = KSS and Sleep and all boxes checked  

no other Extra Columns checked 

TIP:  A plus sign in the column on the far left of the Sleep Schedule Output indicates a shift 

which has been “rolled-up”. Right clicking on a row provides the option to Open all Activities (-) 

or Close all Activities (+). Opening all Activities expands the ‘rolled-up’ shifts, for more 

information on Multiple Shifts Roll-up and how they are determined, see Section 6.1.3.5. 

 
Figure 9-21 Sleep Schedule 1 sorted by Name 
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Figure 9-22 The same Sleep Schedule as in Figure above with Rolled-up Shifts expanded (Rows 3 - 14) 

 

NOTE:  At the bottom of each Sleep Schedule output, a scroll bar allows the user to scroll 

across when Extra Columns have been selected. 

 
Figure 9-23 Scroll bar 
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9.5. External Result Schedule 

 

The External Result screen displays a table output for 

reporting the FAID Score or KSS result for the External 

Results during a specific work period, or within one hour of 

work. 

1. On the Outputs tab in the Schedule section click on the 

External Result   button. 

2. In Display Options from the View drop-down menu 

select the appropriate Work Schedule (1 or 2), and from 

the Result drop-down menu select either KSS or FAID 

Score. 

3. The default Sort By display is sort by Name / Ascending. 

Other sorting options are: 

• Time 

• Result 

• FAID Score 

• KSS 

4. The default Sort By display is sort by Name / Asc 

5. Extra Details provide the opportunity to display FAID, 

KSS, Aviation, and Schedule outputs when viewing the  

External Result Schedule simply by checking the boxes 

against each option.  When extra columns are added, the 

Sort By drop-down menu expands to include those extra 

columns checked. 

 

 

Extra Column selections (depending on what 

Settings have been selected): 

FAID 

• FAID Score 

• Worked FS 

• FAID Score Within 1hr 

KSS 

• FAID Score 

• Worked FS 

• KSS Within 1hr 

Time Zone  

• Location Times 

• Location Time Zones 

 

 

Sleep 

• Sleep 

• Post Shift Rest Quality 

• Sleep Est Prior 24 hours 

• Sleep Est Prior 48 Hours 

• Sleep Type 

Schedule 

• Worked 

Other 

• Activity Code 

• Task Risk 
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9.6. Gantt Chart 

 

 

 

The Gantt Chart is a visual tool that displays each work period 

for individuals within the Work Schedule as a separate coloured 

block. If a Tolerance Level has been nominated, the work 

period is displayed by its Peak FAID or KSS Condition colour.  

1. On the Outputs tab in the Schedule section click on the 

Gantt Chart   button. The Gantt Chart display can be 

changed using the Display Options on the Control Panel. 

2. The Gantt Chart View can be changed to use either Work 

Schedule 1, 2, or a comparison of the two Work Schedules. 

3. The Sort by options available are: 

• Name 

• Peak FAID Score 

• Peak KSS Score 

• FS (FAID Score) Non-Compliance % 

• KSS Non-Compliance % 

4. Result offers the opportunity to colour the display for: 

• FAID Condition 

• Activity 

• KSS Condition 

• Combination of FAID Condition/KSS 

• Combination of FAID Condition/Activity 

• Combination of KSS Condition/Activity 

5. The Gantt Activity Shading legend can be viewed by 

clicking . Additional Activites can be added 

or colours changed in Settings > Aviation > Activity Details 

(see Section 6.1.5.2) 

NOTE:  The way that the shading is presented (activity with 

FAID or KSS Condition in a band in the middle, or FAID or 

KSS Condition with activity as a band in the middle) can 

also be reversed on this screen by clicking in the Yes field. 

The number of IDs can be changed to the user’s needs 

using Range on the Control Panel.  

6. The Period view can be changed using the Scroll Bar on 

the Control Panel. The options are 

• Day  

• Week  

• Month  

• Year  

• Full (Default view) 
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NOTE:  When anything other than Full is selected the Step button  can be used to step to 

the left, right, up or down and the length of the step can be determined (Day, Week, Month, 

Year) by selecting the appropriate Step from the drop-down menu. 

 

 
Figure 9-24 Gantt Chart ranked by Name using Work Schedule 1 showing FAID Condition only 

   
Figure 9-25 Gantt Chart ranked by Name using Work Schedule 1 with a  

Combination of FAID Condition (middle band) and Activity (top and bottom bands) 

 

NOTE: The horizontal scroll bar at the bottom of the graph can be adjusted to change the x-axis 

scale view for the graph. Left click and drag to the left or right the double vertical bars in the 

grey horizontal scroll bar. 

 

 

NOTE: An event details box will display when a block on the Gantt Chart is clicked. The Event 

Details box displays information relating to the selected work period. The user can navigate to a 

more specific table or display for further review. Previous or next shift details can be viewed by 

clicking the orange left or right arrows. 

 
Figure 9-26 Event details displayed for Work Period, use scroll bar to view extra detail 
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9.7. Individual Score Plot 

The Individual Score Plot and Time Zone Movements (when Time Zone movements used 

during analysis) display the progress of an individual’s FAID Score and KSS over the course of 

their work periods (shifts) and the Time Zone Movements (offset from UTC).  If Tolerance 

Levels have been set for the analysis then both the FAID Score and KSS plots are displayed in 

the colour of the highest Condition achieved for each work period. 

Different Individual graphs can be viewed by changing the name within the Summary table at 

the top of the screen, or by changing the rank fields in the Outputs Panel. 

9.7.1. Individual Score Plot – FAID Score 

 

 

1. In the Outputs tab in the Individual Score section, click on 

the Plot Score    button. 

 

2. In Display Options, select the Display from the drop-down 

menu: 

• Single View:  displays the FAID Score Plot and the 

Time Zone Movements (offset from UTC) for an 

individual; 

• Multiple View:  Displays the KSS Score Plot and the 

FAID Score Plot for an individual 

• Compare:  Displays the FAID Score Plot for the 

individual selected and below that the user can 

compare the FAID Score Plot for a different individual. 

3. In the Display Options, select FAID Score from the 

Result drop-down menu.   

4. In the Display Options, Select Work Schedule 1 or 2 from 

the View drop-down menu. 

5. From the Sort By drop-down menu select: 

• Name 

• Peak FAID Score 

• Peak KSS 

• FS (FAID Score) Non-Compliance% 

• KSS Non-Compliance % 
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The TZ Movements (offset from UTC) graph indicates two TZ Movements; one for the work 

period's Location (offset from UTC), and a second for the individual's Body Clock Time Zone 

(offset from UTC). The TZ Movements Plot displays the changes in Location Time Zones for an 

individual across the work schedule, and the individual's Body Clock attempting to align with the 

individual's current location across the work schedule. 

The TZM View options change the Time Zone Movements (offset from UTC), to reflect  

• Location / Body Clock 

• Body Clock Only 

• Location Only 

• None 

NOTE: Night time is determined as between the time of 1800hr and 0600hr. 

 
Figure 9-27 Single View - TZ Movement & FAID Score Plot ranked by Individual, TZM View = Location/Body Clock  

NOTE:  The diagonal bars on the Time Zone Movements (offset from UTC) represent at the 

Time Zone daytime (6am to 6pm) shaded yellow and at the Time Zone night-time (6pm to 6am)  

shaded grey. 

  

 6. Users can view different individual’s FAID Score Plot 

graphs by:  

• Manually entering in the Name in the Rank section of 

the Control Panel (when the Rank By field is set to 

Name); 

• Clicking the Left or Right arrows in the Rank section 

on the Control Panel; or 

7. Manually entering in the Name or selecting a name from 

the dropdown list within the Name field of the Summary 

table. 

8. When Single View is selected from the Display menu, 

select the TZM View required. 
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NOTE:  The bar above the dates are shaded to indicate when sleep opportunities exist for 

either Sleep during the day (light grey) or Sleep during the night (dark grey). 

 

 

NOTE: The horizontal scroll bar at the bottom of the graph can be 

adjusted to change the x-axis scale view for the graph. Left click 

and drag to the left or right the double vertical bars in the grey 

horizontal scroll bar. 

 

NOTE: To get an exact point on the graph; left click on the graph 

(and can also hold down left click and drag around) to reveal the x 

and y axis co-ordinates which are displayed in the top left hand 

corner of the FAID screen.  This is useful when the y-axis scale is 

difficult to read. 

9.7.2. Individual Score Plot – KSS 

 

 

1. In the Outputs tab in the Individual Score section, click on 

the Plot Score    button. 

 

2. In Display Options, select the Display from the drop-down 

menu: 

• Single View:  displays the KSS Score Plot and the Time 

Zone Movements (offset from UTC) for an individual; 

• Multiple View:  Displays the KSS Score Plot and the 

FAID Score Plot for an individual 

• Compare:  Displays the KSS Score Plot for the 

individual selected and below that the user can compare 

the KSS Sore Plot for a different individual. 

3. In the Display Options, select KSS from the Result drop-

down menu.   

4. In the Display Options, Select Work Schedule 1 or 2 from 

the View drop-down menu. 

5. From the Sort By drop-down menu select: 

• Name 

• Peak FAID Score 

• Peak KSS 

• FS (FAID Score) Non-Compliance % 

• KSS Non-Compliance % 

 

6. Users can view different individual KSS Score Plot graphs 

by:  
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The TZ Movements (offset from UTC) graph indicates two TZ Movements; one for the work 

period's Location (offset from UTC), and a second for the individual's Body Clock Time Zone 

(offset from UTC). The TZ Movements Plot displays the changes in Location Time Zones for an 

individual across the work schedule, and the individual's Body Clock attempting to align with the 

individual's current location across the work schedule. 

The TZM View options change the Time Zone Movements (offset from UTC), to reflect  

• Location / Body Clock 

• Body Clock Only 

• Location Only 

• None 

NOTE: Night time is determined as between the time of 1800hr and 0600hr 

 
Figure 9-28 Single View - TZ Movement & KSS Score Plot ranked by Individual, TZM View = Location/Body Clock  

 

• Manually entering in the Name in the Rank section of 

the Control Panel (when the Rank By field is set to 

Name); 

• Clicking the Left or Right arrows in the Rank section 

on the Control Panel; or 

• Manually entering in the Name or selecting from a 

dropdown of the Name Value within the Name field of 

the Summary table. 

7. When Single View is selected from the Display menu, 

select the TZM View required. 
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9.7.3. Multiple View 

Multiple View displays both the KSS Score Plot and the FAID Score Plot simultaneously.  In the 

Display Options select Multiple View from the Display drop-down menu. 

 

9.7.4. Compare FAID Score Plots or KSS Score Plots 

Users have the ability to compare between various Individual FAID Score Plots or KSS Score 

Plots on the one screen. This function can be used to view the differences between various 

individual FAID Score Plots or KSS Score Plots. 

1. In the Display Options panel, click the Display field and change from Single View to 

Compare View  to compare the FAID Score (or KSS Score) 

Plots of two individuals. 

 

Figure 9-29 FAID Score Plots comparing two IDs 
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Figure 9-30 KSS Score Plots comparing two IDs 

2. Change the number in the name detail field to compare a different individuals’ FAID Score 

(or KSS Score) Plot graph with the one at the top of the screen, or click the Left or Right 

arrows on the Outputs Panel. 

  

3. When the Compare View display is selected, the user can click on the Move Details 

 arrows to move an individual either up or down from the top or bottom plot. 

4.   The user has the option to sync the scrolling of both plots, or by toggling the On to 

Off can look at different dates of the FAID Score or KSS Score Plots for either individual. 

 

5. Click in the Display field to return to Single View to return back to the single FAID Score or 

KSS Score Plot display. 

 

9.7.5. Capture Plot 

Users have the ability to capture a screenshot of various graphs and tables within FAID 

Quantum. When FAID Quantum is in Output mode, the Camera Icon will be displayed to 

indicate screen capture availability. Pressing this button will allow the output image to be saved 

as a portable network graphic (.png) file, which can then be printed or inserted into a report as 

required.  

Click the Camera  button to capture a screenshot of all the data on the screen.  

• Enter or select a name for the file. 

• Choose the folder/file to save the file in. 

• Click the Save button. 

NOTE: FAID will automatically save all screenshots as a ‘.png’ file extension. 
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9.8. Individual Score Table 

9.8.1. Individual Score Table – FAID Score 

 

 

NOTE:  The default columns displayed are: 

• +- 

• Name 

• UTC Start 

• UTC End 

  

 

 

 

The Score Table displays the time spent at each FAID Score 

or KSS Condition for each work period or Activity (e.g. 

PAIRINGS or, when expanded, the various Activity Coded 

duty segments: Brief, FL, Debrief etc.).  

1. On the Outputs tab in the Individual Score section click 

the Score Table   button. The Score Table view will 

be displayed. 

2. In Display Options, select the Display from the drop-

down menu: 

• Single View:  displays the FAID Score Table and the 

Time Zone Movements (offset from UTC) for an 

individual; 

• Multiple View:  Displays the KSS Score Table and 

the FAID Score Table for an individual 

• Compare:  Displays the FAID Score Table for the 

individual selected and below that the user can 

compare the FAID Score Table for a different 

individual. 

3. In the Display Options, select FAID Score from the 

Result drop-down menu.   

4. In the Display Options, Select Work Schedule 1 or 2 

from the View drop-down menu. 

5. From the Sort By drop-down menu select: 

• Name 

• Peak FAID Score 

• Peak KSS 

• FS (FAID Score) Non-Compliance% 

• KSS Non-Compliance % 
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Should Extra Column Options be checked in the Work Schedule Outputs, these will 

automatically be viewed in the Score Table:   

KSS 

• KSS Condition Green 

• KSS Condition Yellow 

• KSS Condition Red 

• Peak KSS 

• Peak KSS Condition  

Other  

• Location Codes 

• Activity Code 

• Task Risk 

• Non-Work 

• Work

FAID  

• FAID Condition Green 

• FAID Condition Yellow 

• FAID Condition Red 

• Peak FAID Score 

• Peak FAID Condition 

Time Zone 

• Location Times 

• Location Time Zones 

Sleep 

• Sleep 

• Post Shift Rest Quality 

• Sleep Est Prior 24 hours 

• Sleep Est Prior 48 Hours 

• Sleep Type 

Schedule 

• Show Sleep Schedule 

• Show Work Schedule

 

Figure 9-31 Score Table - Result FAID Score 

NOTE:  Users can alter the view of individual graphs by:  

• Manually entering in the Name in the Rank section of the Control Panel;  

• Clicking the Left or Right arrows in the Rank section on the Control Panel; or 

• Manually entering in the Name field or selecting from a dropdown the Name within the 

Name field of the Summary table. 
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9.8.1.1. Individual Score Plot 

Clicking on a work period row within the Individual Score Table at the bottom of the screen will 

bring up the Individual Score Plot graph for that work period (the row being analysed will now be 

highlighted). 

 

 
Figure 9-32 FAID Score Table analysing a individual, note the expanded Multiple Shifts in rows 4-6 

TIP:  A plus sign in the column on the far left of the Individual Score Table indicates multiple or 

rolled up shifts. Right clicking on a row provides the option to Open all Activities (-) or Close all 

Activities (+). Opening all Activities expands the ‘rolled-up’ shifts.  

NOTE:  At the bottom of the Score Table, the scroll bar allows the user to view additional 

information.  

 
Figure 9-33 Scroll bar 
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9.8.2. Individual Score Table – KSS 

 

NOTE:  The default columns displayed are: 

• +- 

• Name 

• UTC Start 

• UTC End 

  

 

 

 

1. On the Outputs tab in the Individual Score section click 

the Score Table   button. The Score Table view will 

be displayed. 

2. In Display Options, select the Display from the drop-

down menu: 

• Single View:  displays the KSS Score Table and the 

Time Zone Movements (offset from UTC) for an 

individual; 

• Multiple View:  Displays the KSS Score Table and 

the FAID Score Table for an individual 

• Compare:  Displays the KSS Score Table for the 

individual selected and below that the user can 

compare the KSS Score Table for a different 

individual. 

3. In the Display Options, select KSS from the Result 

drop-down menu.   

4. In the Display Options, Select Work Schedule 1 or 2 

from the View drop-down menu. 

5. From the Sort By drop-down menu select: 

• Name 

• Peak FAID Score 

• Peak KSS 

• FS (FAID Score) Non-Compliance% 

• KSS Non-Compliance % 
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Should Extra Column Options be checked in the Work Schedule Outputs, these will 

automatically be viewed in the Score Table:   

KSS 

• KSS Condition Green 

• KSS Condition Yellow 

• KSS Condition Red 

• Peak KSS 

• Peak KSS Condition  

Other  

• Location Codes 

• Activity Code 

• Task Risk 

• Non-Work 

• Work

FAID  

• FAID Condition Green 

• FAID Condition Yellow 

• FAID Condition Red 

• Peak FAID Score 

• Peak FAID Condition 

Time Zone 

• Location Times 

• Location Time Zones 

Sleep 

• Sleep 

• Post Shift Rest Quality 

• Sleep Est Prior 24 hours 

• Sleep Est Prior 48 Hours 

• Sleep Type 

Schedule 

• Show Sleep Schedule 

• Show Work Schedule

 

Figure 9-34 Score Table - Result KSS 

NOTE:  Users can alter the view of individual graphs by:  

• Manually entering in the Name in the Rank section of the Control Panel;  

• Clicking the Left or Right arrows in the Rank section on the Control Panel; or 

• Manually entering in the Name or selecting from a dropdown the Name within the 

Name field of the Summary table. 

9.8.2.1. Individual Score Plot 

Clicking on a work period row within the Individual Score Table at the bottom of the screen will 

bring up the Individual Score Plot graph for that work period (the row being analysed will now be 

highlighted). 
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Figure 9-35 Score Table – KSS analysing a particular Name, note the expanded Multiple Shift in rows 8 - 10 

NOTE:  At the bottom of the KSS Plot, grey bars indicate whether Sleep opportunities are 

during the day (Sleep Day) or during the night (Sleep Night). 

 

Figure 9-36 - Bar showing Sleep Night opportunities 

TIP:  A plus sign in the column on the far left of the FAID Score Table indicates multiple or 

rolled up shifts. Right clicking on a row provides the option to Open all Activities (-) or Close all 

Activities (+). Opening all Activities expands the ‘rolled-up’ shifts.  

NOTE:  At the bottom of the Score Table, the scroll bar allows the user to view additional 

information.  

 
Figure 9-37 Scroll bar 
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9.8.3. Compare Individual Score Tables 

 

 

 

Users have the ability to compare various Individual Score 

Tables on the one screen. This function can be used to view the 

differences between Individual Score Tables. 

 

1. In the Display Options section, click in the Display field 

and select Compare View from the drop-down menu to 

compare the FAID Score Tables or KSS Scores of two 

individuals in the same Work Schedule or the same 

individual in different Work Schedules. 

2. From the View drop-down menu select Work Schedule 1 

or 2. 

3. In the FAID Score Tables screen, in the lower Detail table, 

change the number in the Name value field to compare a 

different Name’s FAID Score Table (or KSS Score Table) 

with the one at the top of the screen or click the Left or 

Right arrows when either in Single View or Compare View 

is selected in Display.  

4.  The user has the option to sync the scrolling of 

both tables or by toggling the On cell to Off can look at 

different dates of the FAID or KSS Score Tables for either 

Name. 

5. In Display, click back to Single View to return back to the 

single Score Table display. 

6. When the Compare View display is selected, the user can 

click on the Move Details  arrows to move a 

Name either up or down from the top or bottom plot. 
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9.9. Sleep Estimate Plots 

 

 

 

 

The Sleep Estimate Plot provides an estimate of the 

opportunities for sleep in the Prior 24 and 48 hours.  

1. On the Outputs tab in the Individual Score section click 

the Sleep Estimate Plots   button. The Sleep 

Estimate Plot will be displayed. 

2. In Display Options, select the Display from the drop-

down menu: 

• Single View:  displays the Sleep Estimate Plot for an 

individual; 

• Compare:  Displays the Sleep Estimate Plot for the 

individual selected and below that the user can 

compare the Sleep Estimate Plot for a different 

individual. 

3. In the Display Options, Select Work Schedule 1 or 2 

from the View drop-down menu. 

4. From the Sort By drop-down menu select: 

• Name 

• Peak FAID Score 

• Peak KSS 

• FS (FAID Score) Non Compliance% 

• KSS Non Compliance % 

 

5. In the View Prior the user has the option to view: 

• All 

• Prior 48 hours 

• Prior 24 hours 

 

NOTE:  Users who are not using the KSS or Sleep Analysis functionality will not be able to 

view the above outputs. 

NOTE:  Users can alter the view of individual graphs by:  

• Manually entering in the Name in the Rank section of the Control Panel;  

• Clicking the Left or Right arrows in the Rank section on the Control Panel; or 

• Manually entering in the Name field or selecting from a dropdown the Name 

within the Name field of the Summary table. 
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Figure 9-38 Sleep Estimate plot for one individual 

NOTE:  The blue and brown lines indicate the Tolerance Levels for Sleep in Prior 24 hours 

(brown) and 48 hours (blue). 

9.9.1. Compare Sleep Estimate Plots 

 

Users have the ability to compare various individuals Sleep 

Estimate Plots on the one screen or compare the same 

individuals Sleep Estimate Plots in different Work Schedules. 

 

1. In the Display Options section, click in the Display field 

and select Compare View from the drop-down. 

2. In the View drop-down menu select Work Schedule 1 or 

2. 

3. From the Sort By drop-down menu select: 

• Name 

• Peak FAID Score 

• Peak KSS 

• FS (FAID Score) Non Compliance% 

• KSS Non Compliance % 

 

4. Users can view different individuals Sleep Estimate Plot 

by:  

• Manually entering in the Name in the Rank section of 

the Control Panel (when the Rank By field is set to 

Name); 

• Clicking the Left or Right arrows in the Rank section 

on the Control Panel; or 
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NOTE:  The blue and brown lines indicate the Tolerance Levels for Sleep in Prior 24 hours 

(brown) and 48 hours (blue). 

 

 

5.  The user has the option to sync 

the scrolling of both tables or by toggling the On cell to Off 

can look at different dates of the Sleep Estimate Plot for 

either Name. 

6. In Display, click back to Single View to return back to the 

single Sleep Estimate Plot display. 

7. When the Compare View display is selected, the user can 

click on the Move Details  arrows to move a 

Name either up or down from the top or bottom plot. 
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9.10. Display of Shift Types 

 

 
Figure 9-39 Types of Shifts for individuals based on the days in the Work Schedule 

 

  

 

In the Utilisation section of the Outputs tab, the Display of 

Shift Types provides an overview of shift patterns based on 

the types of shifts set in the Input tab under Administration / 

Settings (see Section 6.1.1.7). The default view of Shift 

Types gives a count of the number of work periods, starting 

for the particular day that either matches the Shift Definition's 

start and end times, or if no match is found the Shift Definition 

that is closest to the work period's Start Time is used (unless 

changed to Start <= Detail Start Time in Inputs tab under 

Settings). For example; with the default settings in place, a 

work shift that starts at 0630 (when there are two Shift details 

in the list types Day Start Time 0645 and Night start Time 

1845) will display in the Outputs as DAY, as the Start Time of 

0630 is closest to the default ‘Day’ Start Time. 

 

1. On the Outputs tab in the Utilisation section, click the 

Display Shift Types  button. The Display of Shift 

Types table will be displayed. 

2. From the drop-down View menu select Work Schedule 

1 or 2. 

3. Users can alter the view of individual tables by clicking in 

the Display Options drop-down menu. Options available 

are: 

• Shift Type 

• Individuals 

• Gantt  

4. Users also have the option of changing the Show from 

Days in Schedule to a particular Month. 



 

 FAID Quantum User Guide Page 122 of 137 

NOTE: An event details box will display when a block on the Gantt Chart is selected from 

Display Options. The Event Details box displays information relating to the selected work 

period. The user can navigate to a more specific table or display for further review. Previous or 

next shift details can be viewed by clicking the orange left or right arrows. 

 
Figure 9-40 Event details displayed for Work Period, use scroll bar to view extra detail 
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9.11. Work Schedule Profiles 

 

 
 

 
Figure 9-41 Daily Profile graph (UTC) 

 

Daily Profile is the count of the number 

of shifts (y-axis) that start on a particular 

day of the week (x-axis). The user can 

zoom in using the scroll bar at the bottom 

of each graph. 

 

NOTE:  By clicking on the data point or any line on the graph the x and y-axis co-ordinates are 

revealed in the top left hand corner of the FAID Quantum screen. This is particularly useful 

when the axis scale is difficult to read. 

 

 

In the Utilisation section of the Outputs tab Work Schedule 

Profiles provides an overview of the number of work period 

starts (Daily, Monthly, and Hour of Day), number of starts for 

different Shift Lengths, and also a count for non-work period 

lengths (Short < 32hours and Long > 32 hours). 

 

1. On the Outputs tab in the Utilisation section, click the 

Work Schedule Profiles   button. The various Work 

Schedule Profiles will be displayed. 

 

2. Users can alter the Work Schedule viewed by clicking in the 

View box of Display Options.  

 

3. Select the Time from the drop-down menu: 

• UTC; or 

• Local Time 

NOTE:  When Use Time Zone Details = No (see Section 

6.1.1.1) the only option is “local time”.  
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Figure 9-42 Monthly Profile graph 

Monthly Profile provides a count of the 

number of work starts in a particular 

month. 

 

Figure 9-43 Hour of Day Profile graph (UTC) 

 

Hour of Day Profile provides a count of 

the number of work starts in a particular 

hour within a 24-hour period. 

 

Figure 9-44 Work Lengths (Whole Hour) Profile graph 

 

Work Lengths (Whole Hour) Profile 

provides the number of work starts for a 

particular duration, e.g. 21 shifts each of 9 

hours duration. 

 

Figure 9-45 Non-Work Length (Whole Hour) Plot - Short [<=32 
hours] graph 

 

Non-Work Length (Whole Hour) Plot – 

Short [<= 32 hours] provides the number 

of breaks (and their duration) for a 

particular period, e.g. 7 x 22 hour breaks. 

 

Figure 9-46 Non-Work Length (Whole Hour) Plot - Long [>32 
hours] 

 

Non-Work Length (Whole Hour) Plot – 

Long [>32 hours] provides the number 

of breaks (and their duration) for a 

particular period, e.g. 2 breaks of 77 

hours in duration. 
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9.12. Concurrent Work Periods 

 

 

 
 

Figure 9-47 Concurrent Work Gantt Chart 

 

 

The Concurrent Work Periods Gantt Chart shows the number 

of shifts which occur at the same time or overlap and shows 

the minimum number of individuals that would be needed to 

work the hours which have been analysed. 

 

1. On the Outputs tab in the Utilisation section, click the 

Concurrent Work Periods    button.  

 

2. Users can alter the Work Schedule viewed by clicking in 

the Display Options.  

 

 

3. The scroll bar at the bottom can be used to scroll to the 

right or left. 

 

NOTE;  By clicking on a specific Gantt Chart bar, details of 

the shift are displayed. 
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10. Printing 

 

 

  

 

In each section of the Output data, the user has the ability 

to print out data. 

1. Click on the  button to open up the Print Setup 

form. 
 

2. When the user navigates to the Print section it will 

only have the section ticked that the user was 

previously viewing. 

 

3. There is an option for the user to Clear All or Select 

All sections for printing.  
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4. Ensure the Cover Sheet checkbox is checked if a cover sheet is desired. Check the 

required boxes and enter details for the cover sheet: 

• Title (one or two lines) 

• Organisation 

• Date 

• Analysis 

• Tolerance Level 
 

 

5. Select the required sections to print by checking the corresponding checkboxes.  

 

6. If the selection to be printed does not fit on the size of the page required, the user can 

change the column widths (in the Work Schedule) at the top near the column title using the 

mouse cursor, hold down and left click. The software will remember the width and copy to 

all other tables. 

 

7. Select the appropriate page size. 

 

8. Click the Start Print button. The computer’s print options will be displayed. 

 

9. Slect appropriate printer and then click on the Print button. The report will be printed to the 

selected printer. 

 

NOTE:  The Work Schedule views can be quite extensive if there is a lot of data involved, 

where possible the user might want to consider printing to a PDF or print only the Summary 

information. 
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Appendix A:  InterDynamics’ Methodology 

Many organisations faced with the challenge of managing fatigue can easily become daunted 

by the prospect. Impairment associated with fatigue can be difficult to detect, and harder still, is 

judging the level of impairment that could present a danger. Added to the complexity of 

individual differences in experiencing fatigue is the context for individuals (e.g. job type, 

activities, environment, time of day, etc.) and the degree to which this is vulnerable to fatigue. 

Given the diverse factors needing to be taken into account in managing work-related fatigue, a 

risk-based approach that gives consideration to models like James Reason’s ‘Swiss Cheese’ 

model is often recommended. 

 

The Defences-in-Depth model (Dawson & McCulloch, 2005) applies James Reason’s model to 

the fatigue context, targeting prevention through a series of barriers, safeguards, and defences. 

InterDynamics has included these concepts and ideas in its Risk-Based Approach to managing 

fatigue, summarised in the diagram Our Risk-Based Approach to Managing Fatigue at the end 

of this Appendix. 

InterDynamics’ approach recognises the development of an appropriately informed plan to 

manage fatigue (a Fatigue Management Plan) as foundational to the effective implementation 

and on-going improvement of a Fatigue Risk Management System (FRMS). Staff engagement 

and consultation is key to a smooth FRMS implementation, as cultural change is often required 

for the organisation to transition its perception and management of fatigue in line with the 

organisation’s fatigue policy commitment. 

Our experience assisting clients of all sizes across various industries and circumstances has 

brought insights into the most effective organisational team structures and project plans for 

successful implementation. 

• Continuous Improvement

Process       
− Hours of work audit / review

− Timely review of controls

− Occurrence investigation

Layer 1

Layer 2

• Behavioral Symptoms
− Peer identification

− Screening tools

• Corporate Responsibility
− Ensuring adequate sleep opportunity 

− Safe work procedures & training

Layer 3

Critical Incident!!

Layer 4

• Individual Responsibility
− Using time off for rest / fit for duty

− Effective implementation of work procedures

Concept Taken From Managing 
The Risks Of Organizational 
Accidents by James Reason, and 
Union Pacific Railroad
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The aim of the Risk-Based Approach is to provide our clients with the best possible tools and 

resources to manage fatigue risks. It is founded on four pillars: consultation, staff engagement, 

shared responsibility and effective risk management. 

This comprehensive methodology includes three key steps: 

1. Determining the fatigue risk profile of the organisation 

2. Protecting against unacceptable fatigue-related risks 

3. Reviewing systems to ensure protection measures remain adequate 

Suggested FRMS Scope and Implementation activities are outlined in the second & third 

columns of the diagram, respectively. The last column presents supporting InterDynamics 

services and products that facilitate the FRMS journey. Deliverables and findings from each 

implementation activity give additional insight into the organisation’s specific requirements for 

managing fatigue effectively, as well as providing valuable input into the Fatigue Management 

Plan and supporting Work Procedures. 

InterDynamics’ Risk-Based Approach to managing fatigue targets improved safety and 

performance as key outcomes of the FRMS.  

InterDynamics and Zurich Risk Engineering have developed an organisational fatigue risk 

grading system (GRAID™) to provide senior and operational managers with a systematic 

methodology to ascertain the quality of their organisational risks associated with fatigue. In 

conducting FRMS reviews, InterDynamics can provide a valuable third-party perspective on the 

depth, breadth and relevance of your Fatigue Risk Management System. 
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Appendix C:  Inputs Tab Buttons 

Tolerance Level 

Button Name Description 

 
Information 

Provides information on FAID Conditions, KSS Conditions, KSS, FAID 

Score and Hazard Analysis. 

 

Tolerance 

Level 

Provides an overview of the thresholds and measures by which FAID 

Quantum can assist in managing hours of work related fatigue risk. 

 

Schedule 

Button Name Description 

 
Work Schedule Presents Work Schedule 1 or 2 and allows data to be inputted and edited. 

 

Sleep 

Schedule  
Presents Sleep Schedule 1 or 2 and allows data to be inputted and edited. 

 
External Result Presents External Result 1 or 2 and allows data to be inputted and edited. 

 

Copy Work 

Schedule 1 to 

Work Schedule 

2 

Copies shift data entered into Work Schedule 1 into Work Schedule 2 for 

editing. Note this button only appears when within Work Schedule 2.  

 

Admin 

Button Name Description 

 
Settings 

Provides access to Settings, including the setting of default shift patterns 

and Aviation specific settings such as Airport details and in-flight rest 

settings etc. Also provides access to View setup to allow menu buttons to 

be displayed or hidden. 
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Input Table Editing  

Button Name Description 

 
Load Allows a saved Work, Sleep, or External Result Schedule to be loaded. 

 
Copy 

Allows a Work , Sleep, or External Result Schedule to be copied, then 

pasted into another Work, Sleep, or External Result Schedule or exported 

and available to paste into a spreadsheet/database (e.g. Excel) or 

document (e.g. Word).  

 
Paste 

Allows an exported spreadsheet/database (e.g. Excel) Work or Sleep 

Schedule to be imported into FAID Quantum into either Work , Sleep, or 

External Result Schedules. 

 
Save Saves the displayed Work , Sleep, or External Result Schedule to file. 

 
Sort 

Sorts the displayed Work , Sleep, or External Result Schedule by Name 

then by Date. Extra shifts added to a Work , Sleep, or External Result 

Schedule are added at the end of previously entered shifts. The Sort 

button moves shifts into their appropriate order, thereby resolving errors. 

 
Clear  

Clears all data from the displayed Work , Sleep, or External Result 

Schedule. 

 
Sample 

Loads the Sample Work Schedule. This can be used for practice or 

training purposes. If Time Zone Details = Yes in Settings, and In Flight 

Rest Button = Yes this icon is replaced by the Add in Flight Rest icon. 

 

Add In-Flight 

Rest 

Adds predetermined in-flight rest to the work schedule depending on 

length of work periods. 

 
Add 

Displays the Add Work, Sleep, External Result to specific Schedule 

Function to allow shifts, work periods, sleep periods or external results to 

be added to the displayed Schedule. 

 
Delete 

Displays the Delete Row from Work, Sleep, or External Resulkt Schedule 

Function to allow nominated rows in the Schedule to be deleted. (Note: To 

delete only 1 row, the same row number must be entered in both From 

Row and To Row fields. Otherwise FAID Quantum will delete all rows from 

the nominated From Row to the end of the displayed Schedule.) 

 

Copy Schedule 

1 to Schedule 

2 

Copies shift data entered into Work or Sleep Schedule 1 into Work or 

Sleep Schedule 2 for editing. Note this button only appears when within 

Work Schedule 2.  

 

Copy Work 

Schedule to 

Sleep 

Schedule 

Creates a predicted Sleep Schedule based on the existing Work Schedule 

which can be then modified as required. 
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Analysis Run 

Button Name Description 

 

Date and 

Period Wizard 

Ensures analysis will pick up latest Work Schedule data and 

automatically sets the History From Date field to fifteen days 

prior to the Start Date. (Note: To be effective FAID requires 15 

days of data as history to be entered before meaningful analysis 

can begin). 

 
Lock Dates 

Allows the User to Lock the Analysis Dates. When Locked a 

locked icon will appear and the Dates will not automatically 

change when Work Schedule is edited. Only editing the Dates or 

using the Date and Period Wizard can change the Dates. 

 
Analyse 

Performs the Fatigue Score Analysis on any data entered into 

either Work Schedule. 
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Appendix D:  Outputs Tab Buttons 
Summary 

Button Name Description 

 
Summary 

Provides summary Indicative Fatigue Assessments. Includes display 

options for Apparent FTL and KTL, Cumulative Profile by Hours, Hours at 

FAID Score and KSS, Risk Profile, and Shift Peak GYR Condition. 

 

Key Risk 

Indicators 

Displays the Key Risk Indicators Panel on the Outputs Menu: Tolerance 

Level Compliance Percentage, Peak Condition for Work Periods, Hour of 

Day Profiles, Peak Conditions for Rolled Up Shifts and the Monthly 

Compliance Display. 

 

FTL Exposure 

Logs 

Provides details of which work periods (shifts) are exposed to FAID Score 

and KSS condition Red (above TL) and allows risk mitigation steps to be 

recorded. Includes Exposure Only or Exposure and History logs. 

 

Schedule 

Button Name Description 

 
Work Schedule  

Displays the output for Work Schedules 1 or 2 including time in Peak 

FAID Score and KSS Conditions, Peak FAID Scores and KSS and length 

of Work and Non-Work periods. 

 
External Result 

Displays the output for External Results 1 or 2, including Peak FAID 

Score and KSS result at time of external result, or within one hour of work 

period. 

 
Sleep Schedule  

Displays the output for Sleep Schedules 1 or 2, including time in Peak 

FAID Score and KSS Conditions, Peak FAID Scores and KSS and length 

of Work and Non-Work periods. (Visible when no External Results 

display). 

 
Gantt Chart 

Displays planned work periods (shifts) colour coded by the FAID 

Condition and/or KSS Condition of the work period. 

 
Capture Clicking on icon saves Gantt Chart as an image. 

 
Click to move 

When Gantt Chart is shown in anything other than Full view clicking on 

icon moves chart to left, right, up or down. 

 

FAID Score 

Button Name Description 

 
Score Plots 

Displays a Score Plot graph and TZ Movement for individual employee 

Names displaying a profile for each work period (shift), colour coded by 

the Peak FAID or KSS Condition of the work period.  

 
Score Tables Displays a Score Table for individual FAID Score and KSS Outputs. 

 

Sleep Estimate 

Plot 

Provides an estimate of the opportunities for sleep in the prior 48 and 24 

hours. 
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Utilisation 

Button Name Description 

 
Shift Types Provides a visual display of shift types (e.g. Day Shifts vs. Night Shifts). 

 

Work Schedule 

Profiles 
Provides a visual display of Work Profiles.  

 

Concurrent 

Work Periods  

Displays a chart of the concurrent Work Periods (shifts) within a Work 

Schedule. 

 


